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1. Introduction 

The Stage-Discharge Recorder (SDR) is an easy to use device programmed to measure and record water 
levels and flows.  The SDR can be completely setup using the front panel keys and display.  Once 
operational, the SDR will record data at a user set interval with sufficient space to store over two four years 
of data recorded at 15-minute intervals.  The display/keys can be used to review any of the logged data as 
well as real-time operating conditions.  The SDR can also be fully programmed and operated by a PC/PDA.  
Recorded data can be easily transferred to the PC/PDA in spreadsheet-compatible format.  
 

 

Models 
The SDR is available in the following models:  

• SDR-0001-1 SDR with 400-count optical shaft encoder for measuring water levels (shown 
above) 

• SDR-0001-2 SDR with analog input for measuring water levels (see Appendix E).  This SDR 
can be connected to any analog water level sensor, both submersible and non-
contact for measuring the water levels.  This model is no longer available.  Please 
use the -3. 

• SDR-0001-3 This SDR has all the features of  SDR-0001-2 plus extra analog options, including 
a 4-20mA output (see Appendix E). 

• SDR-0001-4 This SDR has both the optical shaft encoder and the expanded analog input 
module (see Appendix E).  It has all the features of  SDR-0001-1 and SDR-0001-
3 

• SD Card Option Above models available with an SD card slot for data retrieval, the part numbers 
are SDR-0001-1SD, SDR-0001-3SD and SDR-0001-4SD.  
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Features 
All models have the following standard features: 
 
• Measures stage and computes discharge at user set interval. 
• Measures stage from one or two of  the following inputs: 

o Built in optical shaft encoder 
o Analog sensor (0-5V, differential, and 4-20mA) 
o SDI-12 sensor 

• Computes discharge: 
o Using standard flume and weir equations. 
o Using a rating table of up to 50 point pairs 
o Through a gate when using upstream and downstream sensors 

• Records/Logs data into ultra-reliable flash memory – no backup batteries needed. 
• Computes daily values (stage, volume, discharge) and logs them at midnight. 
• Records/Logs events to keep track of when anyone uses the front panel and/or makes changes to the 

setup. 
• Runs for 12 months on standard lantern batteries, available in any hardware store. 
• All setup can be done from the front panel of the encoder. 
• Easy to use PC/PDA utilities. Downloads data to PC/PDA as easily read CSV (Comma-separated 

variable) files that can be opened with any text or spreadsheet program. 
• SDI-12 interface for connecting the SDR to Sutron’s Satlink satellite transmitter or other popular field 

stations. 
• RS232 port for connecting the SDR directly to cellular modems for remote access to data. 
• Ground Water Monitor mode useful for measuring and recording ground water level (Appendix F). 
• Modbus slave support  
 

Unpacking  
Remove the SDR from the shipping container and visually inspect the unit for signs of damage during 
shipment. Additionally, rotate the shaft and note any grinding, scraping, or other mechanical problems 
found. Report any such damage to the factory immediately to ensure a prompt response and resolution. 
Retain one shipping container in the event a factory return is necessary. 

 
Please note that if a return is required, a return material authorization (RMA) number is required. To get this 
RMA number, call the Sutron Customer Service Department at 703 406 2800. 



 

Mechanical Features (SDR-0001-1) 
 

 

Units: inches 
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2. Cabling 

Terminal Block Wiring 
The following table contains the pin descriptions for the terminal 
block:  
 

Terminal 
Block Description Notes 

1 BAT G Battery Ground (-) 
2 BAT + Battery + 
3   
4   
5 SDI G Also can be used for Battery Ground 
6 SDI + Also can be used for Battery + 
7 SDI D  
8 Shield  

 
The SDI G and SDI +, can also be used when changing batteries. Simply connect the new battery to these 
terminals before disconnecting the old battery, and the SDR will continue operating without interruption. 
 
The SDR is shipped with a cable that can be used for the connection to a battery.  The cable is provided with 
crimp type fasteners for several types of batteries.  If you are using 6 volt batteries, be sure to use two 
batteries in series. 
 

RS-232 Wiring 
The DB9F connector is designed so you can connect a straight serial cable to the 
SDR from a PC.  When using a PDA or when connecting to a modem, you will 
generally need to use a NULL MODEM.  The PC/PDA software used to 
communicate with the SDR is called “SDRComm”, and is available at no charge 
from Sutron’s web site (www.sutron.com and select “downloads/updates”). 
 
The following table contains pin descriptions for the DB9F connector on the SDR, with the corresponding 
RS-232 cable connections to PC.  
 

DB9F Pin Name Notes 
1 N/C No Connection 
2 RXD Data from SDR 
3 TXD Data to the SDR 
4 DTR Signal to the SDR 
5 Ground  
6 N/C No Connection 
7 RTS Request to Send, signal to the SDR 
8 CTS Clear to Send, signal from the SDR 
9 VOUT Jumper selectable for 5V or VBAT (100ma max) 
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3. Setup and Operation 

This section gives detailed instructions on the setup and operation of the SDR-0001-1, the model with the 
built-in shaft encoder.   
 
If you are using the SDR-0001-2 (analog input), you should still become familiar with the information in 
this section, even though some of the information may not be applicable to your specific model.  Then refer 
to Appendix E for the instructions on using the SDR-0001-2 with analog sensors. 
 
If you plan on using the SDR in Ground Water mode, you should also first become familiar with the 
information in this section and then refer to Appendix F for the details on the Groundwater mode. 
 
For those interested in using two sensors to measure stage one and stage two, Appendix I has additional 
information. 

Power up 
1. Connect a battery (5.5 to 16VDC) to the SDR battery terminals.  Use either the terminals labeled Bat G 

and Bat + or use the terminals labeled SDI G and SDI + 
2. The SDR will briefly flash the green LED while it is powering up.   After a few seconds, the display will 

turn on and display a status message.  The most common status message you will see at startup is “Stage 
not Set” because the SDR cannot track changes to the stage when power is off.  This is a reminder that 
you must set the stage for the SDR to be fully operational.  A few seconds later the stage will be 
displayed.  Until you set the stage, the red LED will also flash as a reminder. 

3. The SDR will retain the date/time and setup information when the power is off.  So, when the SDR is 
powered on, the SDR will begin to operate exactly as it was configured to do so before it was powered 
down.  A small internal battery keeps the internal clock running. 

Setup – Front Panel 
1. The overall menu tree for the SDR is shown on the following page.  The arrow keys allow you to 

navigate the tree to display the desired data or item.   
2. To setup the SDR, use the up and down arrow keys until you see the prompt “Station Setup, Right 

shows details”.  Press the right arrow and you will see the first of the user setup values “Device type”, 
then  press the down arrow to see “Measuring Interval” 

3. To change the value press SET.  The prompt will change and a flashing cursor will appear.  You can 
then use the arrow keys to select a different value. 

4. Once you have the desired value on the display, press SET again to make the change permanent or to 
cancel a change, press the OFF/CANCEL button. 

5. In the case where there are only two possible values for a setting, pressing SET will flip-flop between 
the values and the change is made immediately. 

6. Below is a list of the basic values that can be changed by the user.  Additional settings are required to 
setup analog sensors (see Appendix E) and dual sensor input (see Appendix I). 
• Measuring Interval: 1, 5, 10, 15, 20, 30, 60 minutes  
• Wheel Size: 12 inches, 18 inches, 375 mm circumference 
• Rotation Direction: Clockwise positive, Counter clockwise positive 
• Units: Feet, Meters 
• Right Digits: (0..7) 
• Averaging Time:  (0 to 900 seconds) 
• Discharge: enabled, disabled 
• Discharge Equation: Parshall Flume, Weir (w*Stage^1.5), Generic (A*Stage^B)  (note: the 

appropriate coefficients can be entered once the type of equation has been entered) 
• Gauge Height Shift: xx.xx  (this value is added to the stage prior to its use in the discharge 

equation). 
• Battery Type: 12V Gell Cell, 12V Alkaline, Other 
• Password Setup 
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• Station Name: xxxxxxxxxx 
• Date/Time: yyyy/mm/dd hh:mm:ss 
• WDID: xxxxxxx 
• SDI-12 Address:  The address the unit responds to when queried by an SDI-12 master (0-9,a-z,A-

Z). 
 
 
 



Errors 
Info            
             Logged Daily Stage 
Stage xx.xx ft Right Browses Log
 YYYY/MM/DD HH:MM:SS              
             Logged Volume 
Dschrg xxxxx.xx CFS/CMS              
YYYY/MM/DD HH:MM:SS Logged Stage 

             
Logged Discharge 
             
Logged Battery 

             
      forward in time Volume so far today               
Logged value 
YYYY/MM/DD HH:MM:SS 
             
        back in time 

xxxxx.xxx AF 
             
Battery 13.2V              

Logged Events 
           

             
GPS Status   
Right shows details  
             
Logged Data 
Right shows details 
 
 
             
 
 
 
Station Setup  
Right shows details  
             
SD Card Operations 
SD Card Detected 
             
Station xxxxx 
YYYY/MM/DD HH:MM:SS 
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Device type 
Stage Discharge Rec. | Ground Water Monitor 
             
Measuring Interval 
1 | 5 | 10 | 15 | 30 | 60 Minutes 
             
Wheel Size 
375mm | 12 inch | 18 inches 
             
Rotation Direction 
CounterCW Positive | Clockwise 
             
Units 
Feet | Meters 
              
Right Digits 
3 
             
Discharge Setup  
             
Battery Type (x.xV) 
12V Gell Cell | 12 V Alkaline | Other 
             
Password Setup 
Info 
             
Station Demo1 
2005/04/01 10:30:57 
             
WDID 
             
Enable Garmin GPS 
             
Log Daily Values 
ON | OFF 
             
SDI-12 Address 
0-9, A-Z, a-z 
             
Default Setup 
             
Software Version 

           
Discharge Enabled | Disabled 
             
Discharge Equation 
Generic: A*(Stage^B) Parshall Flume             Weir: W*(Stage^1.5) 
             
Coefficient A                   Parshall Flume Width  Weir Coefficient W 
1.00000                          1 - 600 inches 1.00000 
             
Coefficient B 
1.50000 
             
Gauge Height Shift         Gauge Height Shift  Gauge Height Shift 
0.00000                           0.00000  0.00000 
             
 

Stage Discharge Recorder Menu 
Press SET -- initiate change of 

value 
Changeable values are shown in 

bold on this card 
Press OFF – cancel a change, 

turn display off 
Hold SET – turn on backlight 
Hold  -- increase contrast 
Hold – decrease contrast 

Errors: 
Overspeed – shaft rotated too fast 

and encoder may have missed 
some counts. 

Stage not set – unit operating without 
initial stage setting. 

Battery Voltage low – battery voltage 
less than limit set based on 
battery type. 

Main Menu 

 
 

 
 

 

 

Downlaod Log 
             
Format SD Card 



 

SDR Operations 

Turning on/off the Display 
The SDR will continue to measure and log data as long as a good battery is connected.  The display turns off 
automatically after 5 minutes of inactivity in order to conserve power.  The display can be turned on at any 
time by pressing any key. 
 
To turn off the display, press the OFF/Cancel button.  You may need to press it several times to exit out of 
some menus first.   
Holding the OFF/Cancel button in any menu will turn off the display. 

Turning on the backlight 
The display is equipped with a backlight to assist in viewing in many different lighting conditions. To turn 
on the backlight, simply press and hold the SET button until the backlight turns on. 

 

Adjusting the contrast 
If it becomes difficult to read the display, you may need to adjust the contrast.  To set the contrast, press and 
hold the UP or DOWN arrow buttons until you see the CONTRAST prompt and keep holding the button 
until the display is readable.  If the display becomes too dark or too light, press the opposite arrow key to 
reverse the contrast.  Once the display is readable, release the arrow, and this setting will be stored for the 
next time the display is turned on. 
 
Viewing Current Stage 
The Stage is the first item displayed when the display is turned on (after any informational messages).  The 
display has the format  
 

Stage x.xx ft 
YYYY/MM/DD HH:MM:SS 

 
Where x.xx is the current, live stage along with the time it was measured.  The update time will depend on 
the sensor used and the averaging time setup.  A shaft encoder without averaging will update several times 
per second.  If averaging is enabled (see Averaging Time below), the Stage reading will only update as fast 
as the averaging time.  That means that if the averaging time is set to 10 minutes, the display will update only 
once every 10 minutes!   
 
Remember that a “?” after the units on the top line is a hint that the stage needs to be calibrated.  The 
procedure for calibrating the stage is given in the following section. 
 

Calibrating the Stage 
You can calibrate (set) the stage from any of the menus that displays the live stage.  Simply press the SET 
key.  The display will change the prompt to “Setting Stage”.  Use the arrow keys to change any of the digits 
in the display.  When the value is correct, press SET.  To discard the entered value, press CANCEL. 
 
If averaging is enabled (see Averaging Time below), you will need to wait an amount of time equal to 
Averaging Time before you can enter the new stage.  
  

Viewing Discharge 
The Discharge is immediately below the stage in the main menu.  It is available only when the SDR has been 
setup to compute the discharge. (Refer to Chapter 4 for a complete discussion of how an SDR computes 
discharge.)  Press the down arrow (from Stage) to view it.  This value is also a live value, updating several 
times a second.  The Discharge is computed based on the type of calculation selected (Equation or Rating 
Table) and the corresponding coefficients.  The units for the discharge will be CFS (cubic feet per second) if 
the stage units are in feet and CMS (cubic meters per second) if the stage units are in meters. 
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Viewing Volume So Far Today 
The Volume so far Today is immediately below the Discharge.  This is the amount of water that has flowed 
by the SDR since midnight.  The units of the volume are Acre Feet (1 Acre Foot = 43,560 cubic feet or 
325,828.8 gallons) if the stage units are in feet and TCM (thousand cubic meters) if the stage units are in 
meters.  This value is computed from the data logged by the SDR along with an estimate based on the current 
discharge and the last logged value.  The estimated part of the volume may go up or down as the current 
discharge changes.  At the end of each day, the SDR will make a conclusive calculation on the amount of 
water that has flowed – see Volume below. 

Logged Data 
The SDR features a flash log chip on board capable of holding over 300,000 log entries.   Each log entry is 
self-sufficient, making the log very reliable (there is no log table that can be corrupted).  The log cannot be 
erased.  Once the log is full, the oldest entries will be overwritten. 
 
Logging is enabled as soon as the unit is powered on.  The unit will log data and events.  Data refer to sensor 
data such as water level and discharge.  Events refer to occurrences such as power up, setup change, display 
on, login fail, hardware errors, etc.  Events make it easy to diagnose any issues that may have occurred with 
the station.  The fact that the unit logs as long as it has power makes it reliable and robust. 
 
Measuring stage and discharge every 15 minutes, the unit can store over four years of data in the log! 

Measurement Interval 
The measurement interval decides how often the SDR should log water level data.  This is a user setting that 
can be changed from the front panel under the Station Setup->Measurement Setup menu.  This value can be 
set to 1, 5, 10, 15, 30 or 60 minutes. 
 
The SDR stores the following data in its log:  
 
Item Interval Description 
Logged Stage Stage Interval Instantaneous Stage measured at the 

specified time. 
Logged Discharge Stage Interval 

when enabled 
Instantaneous Discharge computed at the 
specified time. 

Logged Daily Stage* 23:59:59 Daily average stage computed from 
instantaneous stage values made during 
that day. 

Logged Volume* 23:59:59 Daily Volume computed from discharge 
values logged during the day** 

Logged Daily 
Discharge* 

23:59:59 Daily Discharge is the average of all the 
logged discharge readings during the day. 

Logged Battery* 23:59:59 Battery voltage measured at the specified 
time. 

Logged Events As they occur  Events are occurrences such as power on, 
log download, overspeed, upgrades, and 
so on. 

Log Daily Values* 
At the last second of every day (23:59:59), if Log Daily Values is enabled, the SDR will compute and log 
various measurements.  These include daily stage, daily discharge, volume, and battery voltage.   

Volume** 
At midnight of every day (if Log Daily Values is enabled), the SDR computes Volume.  Volume is the 
amount of water that has flowed by the SDR over the course of one day.  The units of the volume are Acre 
Feet (1 Acre Foot = 43,560 cubic feet or 325,828.8 gallons) if the stage units are in feet and TCM (thousand 
cubic meters) if the stage units are in meters.  Volume can be seen via the front panel as Logged Volume. 
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These steps are taken to compute Volume 
• At midnight, one final discharge reading is made 
• All discharge readings for the day are read from the log 
• The average of a pair of consecutive discharge readings (CFS) is computed and multiplied by the 

time amount between the pair (seconds) resulting in a partial volume (CF). 
• All the partial volume computations are summed up. 
• The sum is converted from CF to AF (or from CM to TCM). 

 
Example (only partial daily data shown): 
 

Time 
Discharge 
CFS 

Average 
Discharge 
CFS Time passed (sec) Partial Volume CF 

06/30/2007 18:00:00 6.6 6.7 3600 24120
06/30/2007 19:00:00 6.8 7.0 3600 25200
06/30/2007 20:00:00 7.2 7.1 3600 25560
06/30/2007 21:00:00 7.0 7.1 3600 25560
06/30/2007 22:00:00 7.2 6.8 3600 24480
06/30/2007 23:00:00 6.4 6.2 3600 22320
07/01/2007 00:00:00 6.0    

   Total Volume CF 147240
   Total Volume AF 3.38
  
 

Viewing Logged Data 
To view logged data, use the arrows to display the menu: 
 

Logged Data 
RIGHT shows details. 

 
Then press the right arrow to bring up the logged data sub menu.  The following menu will be displayed: 
 

Logged Daily Stage 
RIGHT Browses Log/SET Searches by Date 

 
Use the up/down arrow keys to select the desired item (Logged Daily Stage, Logged Volume, Logged Stage, 
Logged Discharge, Logged Battery, Logged Events, Entire Log) and press either the right arrow or the set 
key.   
If the right arrow is pressed, the last logged value for the item will be displayed along with the date/time, 
units and possibly the “?” indicator (see below).  Press the down arrow to go back in time and the up arrow 
to go forward.  When you reach the end of the log, a message will be displayed.  Continuing to press the 
arrow will wrap to the oldest or most recent values.   
If instead of pressing right, set is pressed, a date and time can be entered.  Once entered, the log will jump to 
that date and allow further browsing using the up and down arrows. 
 
Note: when in the log viewing, the contrast adjustment is disabled so you can hold an arrow key to “scroll” 
up and down through the log. 
 



Understanding the “?” indicator. 
The SDR displays a “?” after a value if there is a question about the quality of the data.  This always happens 
on startup because the user needs to set the stage to the current value.  The “?” is a reminder that user action 
is needed for the station to be operational.  The following table gives a description of how “?” is used: 
 
Stage/Logged Stage Stage not set or overspeed (shaft rotated too fast) or user changed setup 

without recalibrating or time not set 
Discharge/Logged Discharge Stage used to compute discharge is “?” 
Logged Daily Stage One or more of the stage used in the average is “?” 
Logged Volume One or more of the discharge used in the total is “?” 
 
You can look at the events in the log to determine the exact time of the event that caused the questionable 
data.  This can be used to help reconstruct the data should there be an error. 
 

Logged Events 
Events refer to occurrences such as power up and setup change that are recorded in the log.  Events make it 
easy to diagnose any issues that may have occurred with the station.   
 
Event When is it logged? What does it signify? 
   

Reset Powerup Unit is powered on Unit was powered on or hard reset  
Reset Upgrade Firmware upgrade Firmware was upgraded 
Reset other Unit rebooted Software problem caused unit reboot 
Time Before Change System time is changed The time of the unit before the change 
Time After Change System time is changed The time of the unit after the change 
Before Cal Measurement calibrated Sensor reading before calibration 
After Cal Measurement calibrated Sensor reading after calibration 
Log Download Log is downloaded Log was download 
Setup Change Setup is changed Setup was changed 
Overspeed Shaft moved too quickly Stage may not be correct 
Hardware Fail Hardware error noted Unit may need to be sent back for repair 
Display On Front panel activated User is at the site 
Display Off Front panel deactivated User has left the site 
Login Fail User entered password Invalid password entered 
Login Valid User entered password Valid password entered 
Password changed Password protection changed Password was enabled, disabled or changed 
No GPS time fix GPS time sync  GPS could not acquire satellite fix  
GPS Comm problem Once a day if errors occur Problem talking to GPS module 
 

Retrieving Data 
You will need to use the PC/PDA SDRComm programs provided by Sutron to retrieve data from the SDR.  
These programs can be downloaded from the Sutron web site (go to www.sutron.com and select 
“downloads/updates”).  Both programs make it easy to download the data as well as view the data and graph 
it.  The download data will reside in a file “station name YYYY-MM-DD.CSV” with the actual station name 
and the date of the download in the name. 
 
Please note that Sutron provides a PC program called Sutron Grapher that can be used to graph SDR log 
files.  The software can be found at www.sutron.com. 
  

Password 
The station can be protected with a password.  If protection is enabled, no user will be able to make any 
changes to the station without first entering the password.  Data and setup can be viewed but not changed 
unless the password is first entered. 
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To enable the password, go to the Station Setup->Other Setup->Password menu.  Press SET and enter the 
new password.  To disable the password, enter a blank password.   
 
If a station is protected by a password, any attempt to change a setting will result in the ‘log in’ menu 
appearing which will provide the user a chance to enter the correct password.  A new log entry will be made 
every time a password is entered.  The station will write either ‘Login Fail’ or ‘Login Valid’ to the log. 
 
A password is never needed when using the PC/PDA programs.  If you forget the password and want to clear 
it, remove power to the unit and then reapply power while holding the DOWN key.  You must keep the 
button pressed until you see the message “Password Cleared”. 

Averaging Time 
With SDR software version 3.00, an averaging option has been added.  SDR does simple averaging, 
meaning that it will collect data the user specified amount of time.  Once the time is up, it will sum up all the 
samples and divide the sum by the number of samples collected.   
 
Averaging Time is expressed in seconds.  It can be found under Station Setup ->Averaging Time.  If that 
time is zero (which is the default), no averaging is done.  If it is not zero, the SDR will collect data for 
however long the averaging time is setup for.  The value can be set anywhere from 0 seconds (no averaging) 
to 900 seconds (which is equal to 15 minutes).   
 
Please note that the SDR’s Stage reading on the front panel will only update as fast as the averaging 
interval.  That means that if the averaging time is set to 10 minutes, the display will update only once every 
10 minutes!   
 
The SDR will collect approximately two samples per second from the shaft encoder.  For example, with a 
shaft encoder, if averaging is set to 5 seconds, the SDR will collect 10 samples from the encoder, sum them 
up, and divide the resultant sum by 10.  The final result is the stage.   
 
Make sure the averaging time is less than the measurement interval.  If the averaging time is close to the 
measurement interval, the SDR may miss measurements!  This means that if the Measurement Interval is set 
to 1 minute, make sure the averaging interval is significantly less than 60 seconds.  

SD Card Interface 
The SDR supports SD card usage for downloading logged data and setup changes.  An SD card is a portable 
media storage that is widely available on the commercial market.  MMC cards may also be used with the 
SDR. 

SD Card Log Download 
To download the log using an SD card, simply plug the card in.   

• If the front panel is off when the card is plugged in, an automatic log download will start in 10 
seconds.  The automatic download will download since last download.   

• If the display is on when the card is plugged in, the download log menu will appear.  Navigate the 
menus and choose the appropriate log download type. 

There is a red LED that will light up while the SD card is in use.  Please do not remove the card when it is in 
use. 

Automatic Log Backup 
If an SD card is left plugged in, the unit will perform an automatic backup of the log to the SD card.  All the 
user needs to do is leave the SD card plugged in, and the SDR will periodically download the log and save it 
to a file on the SD card.   
 
With an SD card left plugged in, four hours after the user stops using the display, and every four hours 
afterwards, the unit will download the logged data and append it to a file.  Once the file exceeds about 2MB, 



a new file will be started.  The backup will work until the SD card gets full, at which point it stops 
downloading. 
 
When visiting the station for maintenance to retrieve the log, it is only necessary to remove the card that was 
left plugged in. 
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PC/PDA Operation With SDRComm 
SDRComm is a program for the PC or PDA that allows you to see current measurements and status, 
configure the unit, and to download data into both csv files and graphs. SDRComm can also be used to 
upgrade the SDR firmware. Separate programs exist for the PC and PDAs, SDRCommPC and 
SDRCommPPC. The PC version runs on any PC running Microsoft Windows 98 or later. The PDA version 
runs on any Pocket PC compatible PDA (e.g., HP iPaq).  These programs can be downloaded from the 
Sutron web site (go to www.sutron.com and select “downloads/updates”).  Please see the downloaded files 
for installation instructions. 
 
Note: The pictures of SDRComm shown in this manual are of the PC program. However, all of the 
operational description that follows applies to the PDA program as well, since it has exactly the same menus, 
buttons, and tabs. Since PDAs do not have a “tab” button, you select a new field by tapping it with the PDA 
stylus. 
 

Main Tab 
The main tab of SDRComm is shown below.  This tab displays important status information including 
calibration status, battery voltage, discharge calculation status, and the current values for stage, discharge 
and volume.  
 
Pressing “Refresh” causes SDRComm to retrieve updated values from the SDR. Pressing “Set Time” brings 
up a dialog that allows the time of the SDR to be set. Pressing “Cal…” prompts you for the current stage 
value in order to calibrate the stage. 
 

 
 
 

File Menu 
The File menu contains an “Exit” item. Use this item to exit the program. Note: On the PDA version of 
SDRComm, using this menu option is required to fully exit the program and close the serial port. If the small 
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“X” in the upper right corner of the window is clicked instead of “Exit”, the PDA program does not fully 
close, but only minimizes, keeping the serial port open. 
 

Tools Menu 
Menu items under ‘Tools” can be used to perform several useful functions. “Get SDR version” retrieves the 
version of the SDR firmware. “Upgrade Firmware” prompts you to select an upgrade file that will upgrade 
the SDR firmware to a new version (these upgrade files are delivered with the SDRComm installation 
package).  
 
The “Set setup to default” menu will cause the SDR to reset its configuration to the default settings. The 
password can be reset (i.e., to no password) using the “Reset password” menu item. 
 
The “Change device type…” menu item under Tools is used to configure the attached device to be an SDR, a 
Water Monitor (a variant of the SDR device – see Appendix F – Ground Water Monitor device type), or to 
be a DitchMaster (an irrigation control device which has its own manual, available from www.sutron.com). 
Only change this setting if you are sure you need to. After changing the setting, it is recommended that the 
unit be rebooted and the setup changed to defaults. 

Options Menu 
The Options menu “Set Comm Port” item is used to define the PC or PDA communications port to which the 
SDR is connected (e.g., COM1, COM2, etc.). The “TCP/IP” option is intended for use with Serial IP 
modems like the Airlink “Raven” cell modem. 
 
Additionally, the “Update Periodically” feature allows the Main tab to refresh the data it gets from the SDR 
periodically. 
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Setup Tab 
The Setup tab is shown below. This tab used to view and define the SDR configuration. When this tab is 
selected, the current configuration is displayed and SDRComm reports “Setup is in-sync with device” in the 
status pane at the top of the window. If you make any changes to any of the parameters displayed on this 
page, the status pane reports that the setup has changed, and reminds you to press “Send Setup” to send the 
changes to SDR. To restore the changed parameters back to those that are in SDR, simply press “Get Setup”. 
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Pres the “Config Sensor” button to bring up the window that gives access to the sensor setup: 
 

 
 

Unless the SDR is equipped with the optional analog inputs, that section will not be available for setup.  
Please refer to the section Appendix I – Dual Sensor to learn more about configuring dual sensors. 
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Discharge Tab 
Use this screen to enable and setup discharge.  Please see the section 4. Practical Applications - Working 
With Discharge to learn more about properly configuring discharge. 
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Data Tab 
The Data Tab is shown below. This tab is used to view recent data, and to download data into csv files or 
graphs. When the Data tab is first selected, it automatically downloads the most recent 12 hours of data and 
displays it in the list box. The list box may be sorted by clicking on one of the column headers. The list will 
be sorted according to the contents of the column clicked. You can also rearrange columns by clicking and 
dragging the columns into the desired order.  
 

 
 

The “Filter” field allows you to narrow the set of data to display. Selecting “Data” displays stage, discharge, 
volume, and battery voltage, as well as daily values.  Selecting “Events” will cause the list to contain only 
event items, e.g., display on, display off, log download, etc. These events are useful in determining what 
users have done to the unit since it has been in operation. Other “Filter” possibilities allow you to view only 
stage, or volume, etc. 
 
To add more data to the list than it currently contains, press the “More” button. You will then be prompted 
for how much data to add (one day, one week, or one month).  
 
Pressing “Refresh” will cause SDRComm to retrieve the data again, including any data that has been 
generated since the last download.  
 
To graph the data that is currently in the list, press “Graph”. This will bring up a new window containing a 
graph.  
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Graphing Data 
When the graph window is first shown, it defaults to graphing Stage. Other values may be graphed by 
changing the “Series” field.  
 

 
 
To zoom-in on an area of the graph, click and drag your mouse across that area. To return to the last zoom, 
press “Zoom Out”. To return to the entire span (no zoom), press “Zoom Normal”. Pressing “Close” closes 
the graph dialog. 
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Downloading Data 
To download data, press the “Download” button on the Data tab. This causes the following window to 
appear.  
 

 
 
The “Download” drop-down list allows you to select the span of data to download. You can download the 
whole log, the last 7 or 30 days, or data that falls within dates you specify in StartTime and End Time. Use 
the “Browse” button to define where to put the resulting csv file.  
 
The “Content” drop-down list is used to define the content of the downloaded data. The options are “Data”, 
“Events”, or “Both”.  
 
The “Format” drop-down list is used to select the type of CSV format of the output file. The options are 
“Group” and “Flat”. The “Group” format puts all values having the same date-time on the same line in the 
file, while the “Flat” format puts every log entry on a separate line. Each format puts text at the beginning of 
the file that defines the fields in the file. 
 
If “Separate date/time fields” is selected, the output file separates the date and time fields with a comma. 
Otherwise, date and time are separated with a space, which allows Excel to sort on date-time. 
 
Pressing the “Download” button starts the download. 
 
If “Open after download” is checked, the csv file will be opened in an external viewer, e.g., Microsoft Excel,  
after it is downloaded (the Pocket Word application is used on Pocket PCs, since Pocket Excel does not 
support the CSV format). For this to succeed, you must have a program on your PC that has registered itself 
as a csv viewer. Microsoft Excel does this by default. If you do not have a registered csv viewer, you can 
still open the downloaded file in a text editor, e.g., notepad, to view its contents. 
 
If “Display graph after download” is selected, the data that is downloaded will be opened in a graph. The 
window will display a graph of Stage by default, but other values may be selected in the graph window.  
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Data Polls Using SDRPoll 
SDRPoll is a program for the PC that is used to automatically download log data from the SDR at specified 
intervals.  
 
SDRPoll Highlights: 

• Executes user-defined periodic schedule to download data from an SDR. 
• Multiple schedules/stations are possible.  
• Schedules can be daily, hourly, every few minutes, etc. 
• The downloaded data is appended to a csv file. 
• Supports direct, Modbus and ip serial bridge (e.g. Airlink Raven) connections.  

 

Main Window 
Here is a picture of the main screen, followed by descriptions of each of the columns: 
 

 
 
Name The name of the SDR station. 
Port The com port or ip address of the SDR. 
Enabled? Indicates whether schedule is currently enabled (schedules can be disabled manually by 

user to support maintenance, etc.). 
Last Comm Date and time of the last successful download. 
Next Comm Date and time of the next scheduled download. 
Status Text that describes either the current operation, or the results of the last operation. 

When an error occurs, this field explains the nature of the error, and the entire row is 
highlighted yellow.  

Status Bar Current date and time. 
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Schedule Details 
The following dialog allows the user to create a new poll schedule, or to edit an existing poll schedule. To 
create a new poll entry, select “New” from the “Edit” menu. To edit an existing poll schedule, highlight the 
entry in the list and then select “Edit” from the “Edit” menu, or right click on the entry and select “Edit” 
from the pop-up menu.  
 

 
 

Enabled schedule Indicates whether schedule is currently enabled (schedules can be disabled 
manually by user to support maintenance, etc.). 

Station name Typically the name of the SDR from which to download.  
Device type This defines the device that is being connected to, either SDR or Water Monitor.  

This selection determines the header information placed into the log when 
downloaded. 

Num attempts This is the total number of times to try for a successful download.  
Connection type This drop down box is used to select the type of connection to the SDR device. 

You can select from “Direct”, “TCP/IP”, and “Modbus”. To change the 
parameters for the connection type selected, press the “Connection Settings” 
button.  

Conncection Settings See below for descriptions of the different connection setting parameters. 
Adifferent set of settings are shown for each selection made in the Connection 
type drop down box, described above. 

Offset The schedule offset time. 
Interval The schedule offset interval. 
Download type This defines the span of the data to download. Possible selections: 

Since Last: Download all data since last successful download (if no previous 
download, use schedule interval as download span). 
Recent Span: Use “Download span”. 
Whole Log: Download the entire log. 

Download span Span of data to download when “Recent Span” is selected for download type. 
Local time offset Set this to the difference in minutes between the device’s system time and the 

PC’s system time. 
Output format “Flat” format puts one log item on each line of csv output, while “Group” format 

groups all items with same date-time into a single row, multi-column format. 
Right digits The number of right digits to use when formatting the downloaded data. 
Output file Path to the csv file in which to store downloaded data. 
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Connection Settings: 
Clicking this button brings up the connection properties window.  The options available to the user will 
change depending on the type of connection selected under Connection Type.   
 
TCP/IP 
If you are using an IP modem to connect to the SDR (e.g., the Airlink “Raven” IP modem that serves as a 
serial bridge over an IP network), then you will select TCP/IP for the Connection Type. When TCP/IP is 
selected, the Connection Settings dialog contains the following settings… 

 

 
 
IP address The IP address of the IP modem that is connected to the SDR device.  
IP port Tthe IP port to which the IP modem responds.  

 
MODBUS 
Using the MODBUS protocol to poll the SDR is advantageous when you have multiple SDRs connected on 
the same spread spectrum radio network, and you need a way to uniquely address each of them. When 
Modbus is selected, the Connection Settings dialog contains the following settings… 
 

 
 

Device ID The address of the sensor to communicate with. 
Com Port The desired port to connect with. 
Baud A drop down list containing the available baud rates the unit can operate at 

ranging from 1200 to 19200.  The default is 19200 and is recommended for all 
applications. 
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Parity A drop down list containing the available parity choices:  Odd, Even, None.  The 
default is Even. 

Protocol * A drop down list containing the two Modbus protocols:  RTU and ASCII.  The 
default is RTU.   
Note: If using RTU, be sure to setup modems or any other communication 
equipment to use 8-bit data.  If using ASCII, use 7-bit data. 

RTS pre-tx delay The number of ms to assert RTS before transmitting data.  This value defaults to 
10 and is sufficient for most applications.  This setting is typically of concern 
when RTS is used to “key” the radio, i.e., to push the “button” that tells the radio 
here is your data to send. Larger values allow the radio to warm-up before data is 
sent to them for transmission.  

RTS post-tx delay The number of ms to continue asserting RTS after transmitting data.  This value 
defaults to 10 and is sufficient for most applications.  This setting is typically of 
concern when RTS is used to “unkey” the radio, i.e., to release the “button” that 
tells the radio that no more data will be sent to it for transmission. Larger values 
allow the radio to complete its current transmission before the “button” is 
released. This can be important when using radios that go to sleep when RTS 
drops, regardless of whether the current data transmission is complete.  

Wait for DSR If checked, the pc will wait until the Date-Signal-Ready line is asserted before 
transmitting data. 

Wait for CTS If checked, the pc will wait for the Clear-To-Send line to assert before 
transmitting data. 

Default slave timeout The amount of time in milliseconds the software will allow for a reply from the 
device at the Device ID address.  The default value is 2000.   
 
Note: If data being requested is long in the past, a longer timeout may be 
necessary to allow for the unit to parse its log completely.  If this is the case, a 
timeout of 10,000 should be sufficient. 

 
* Sutron recommends that customers using MDS 9810 spread spectrum radios use the ASCII protocol.  
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SDI-12 Sensor Operation 
In addition to recording data, the SDR can function as an SDI-12 Sensor.  This allows the SDR to connect to 
another data logger or transmitter to provide the data when requested.   If you are not using the SDR with 
another data recorder or transmitter, you can skip this section. 
 
The SDR is compliant with SDI-12 Specifications version 1.3.  SDI-12 is a standard for interfacing data 
recorders with microprocessor based sensors.  More details on the SDI-12 interface can be found at 
http://www.sdi-12.org. 
 
All standard SDI-12 1.3 commands are supported. The SDR will respond to the following commands. 

A! Change Address command 
The default SDI-12 address is 0. If you are using the SDR connected with other SDI-12 devices, you will 
need to have a unique address for each sensor. Note: If the current address is unknown, make sure the SDR 
is the only sensor on the SDI-12 bus, then issue an ?! command and the SDR will respond with its current 
address. 
 

Send : aAb! 
Response: b 
 
Where: 
a is the current address of the SDR 
A is the change address command 
b is the desired new address 
 

I! Identify command 
The identify command will respond immediately (no aD0! needed) with specific information on the SDR 
about the SDI-12 compliance level, manufacturer, model number and firmware version. This information 
may be useful when customer service is assisting in troubleshooting a trouble site. 
 

Send: aI! 
Typical Response: a13 SUTRON SDR001Vx.xx 
 
 Where: 
a is the SDR address 
SUTRON SDR001 is the manufacturer and model number 
Vx.xx is the current firmware version 
 

V! Verify command 
The data value returned is an indication of the error status. If the unit is operating properly, then a 0 is 
returned. If the unit has any errors, then a 1 is returned. This error status returned follows the status reported 
on the front panel via the heartbeat LED (e.g. Green LED, no errors and Red LED errors present). 

 
Send : aV! 
Response: a0001 
 
Where: 
a is the address of the SDR 
000 means data is ready immediately 
1 means 1 data item will be returned. 
 
Send: aD0! 
Response: a+E 
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Where: 
a is the address 
E is a 0 or a 1 indicating the error status 
 

Measure Commands 
The SDR supports several measurement commands. They can be initiated with Start Measurement (M! or 
MC!) or Start Concurrent Measurement (C! or CC!) commands, where the extra "C" means add CRC. The 
continuous measurement commands (R! or RC!) will not return any data.   
 
The SDR will return the data values in whatever measurement units have been configured in the SDR setup 
(meters or feet). The SDR measurement units cannot be changed or read via any SDI-12 command. 
 

M! Measure current Stage/Discharge  
The SDR will immediately proceed to measure stage and discharge. Three values are returned: stage, 
discharge and quality.  If discharge measurements are disabled, the discharge value returned will be zero. 
The number of right digits used in the stage measurement is configurable through the front panel or the SDR 
communicator. The number of right digits in the discharge measurement is not configurable. The quality 
reading will be 0 if the data is good, 1 if there is an overspeed condition, 2 if stage is not set, or 3 if both 
stage is not set and an overspeed is present.  Also see the M4 command.  

 
Send : aM! 
Response: a0005 
 
Where: 
a is the address of the SDR 
000 means data is ready immediately 
5 means 5 data items will be returned. 
 
Send: aD0! 
Response: a+ss.ss+dd.dd+q+bb.bb+r 
 
Where: 
a is the address 
ss.ss is the current stage reading 
dd.dd is the current discharge 
q is the quality of the stage reading flag 
bb.bb is the secondary sensor reading (stage2) 
r is the quality of the secondary sensor 

 

M2! Get calculated Stage/Volume from yesterday 
The SDR will return yesterday’s calculated daily stage and volume (values calculated at 23:59:59 when 
viewed in the log).  If discharge measurements are disabled, the volume returned will be zero.  If the SDR 
has been reset since yesterday, both readings will return as 0. 

 
Send : aM2! 
Response: a0002 
 
Where: 
a is the address of the SDR 
000 means data is ready immediately 
2 means 2 data items will be returned 
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Send: aD0! 
Response: a+ss.ss+vv.vv 
Where: 
a is the address 
ss.ss is yesterday's average stage reading 
vv.vv is  yesterday’s daily volume 

M3! Measure Battery Voltages 
The SDR will return  two battery readings.  The first is the reading on the BAT connector, the second 
reading is on the SDI-12 + connector. 

 
Send : aM3! 
Response: a0002 
Where: 
a is the address of the SDR 
000 means data is ready immediately 
2 means 2 data items will be returned. 
 
Send: aD0! 
Response: a+bb.bb+vv.vv 
 
Where: 
a is the address 
bb.bb is the current voltage on the BAT connector 
vv.vv is  the current voltage on the SDI-12 + connector. 
 

M4! Last Measured Data 
The SDR will instantly return  sensor readings from a previous measurement.  The previous measurement 
may have occurred due to a scheduled measurement, front panel interaction, or even a different SDI-12 
command.  In any case, this command will return the result from the last measurement made by the SDR.  
The formatting is the same as the M! command, the difference being that M! causes a new measurement to 
be made while M4 returns the last measured data.  Use this command to make sure the data in the SDR and 
in the connected data logger is identical. 
 

Send : aM4! 
Response: a0005 
Where: 
a is the address of the SDR 
000 means data is ready immediately 
5 means 5 data items will be returned. 
 
Send: aD0! 
Response: a+ss.ss+dd.dd+q+bb.bb+r 
 
Where: 
a is the address 
ss.ss is the current stage reading 
dd.dd is the current discharge 
q is the quality of the stage reading flag 
bb.bb is the secondary sensor reading (stage2) 
r is the quality of the secondary sensor 
 



C!, MC! and CC! commands 
The C command is used to make a concurrent measurement.  It operates identical to the M command except 
that the shaft encoder does not issue a service request when the measurement is complete. This is useful 
when multiple SDI-12 sensors are being measured, such that all sensors can start measurements at the same 
time, then the data recorder can get the data back when the sensor with the longest measurement time has 
completed. 

 
The MC command is identical to the M command except that the shaft encoder adds a CRC to the end of the 
data. This is useful when the sensor and data recorder are separated by a distance in an electrically noisy 
environment  as it adds extra CRC calculations to ensure the data integrity. 

 
The CC command is identical to the C command except that the shaft encoder adds a CRC to the end of the 
data. This is useful when multiple sensors and a data recorder are separated by a distance in an electrically 
noisy environment  as it adds extra CRC calculations to ensure the data integrity. 
 

XS! Set Stage Extended Command 
This command will set the current stage reading in the units currently configured in the SDR (e.g. If the SDR 
is reading in feet, then the value entered here must be in feet).  It is equivalent to setting the stage via the 
front panel or using the SDRComm program. 
 

Send: aXS±<value>! 
Response: a 

 
Where: 
a is the address 
XS is the command to set the current stage 
±<value> is the new stage value.  The new stage value must start with a polarity sign (+ or −), 
which must be followed by one to seven digits including an optional decimal point.   
 
Example of the set stage command: 
0XS+1.234! 
Sets the stage to 1.234  

 

XDT! Set/Read Date and Time Extended Command 
Use this command to change the current date and time of the SDR, issuing this command with no data will 
return the current date and time in the SDR. 
 
To set the date and time: 

 
Send: aXDTYYYY/MM/DD HH:MM:SS! 

 
 Where: 

a is address 
XDT is the command to set the date and time 
YYYY is the year 
MM is the month (01 to 12) 
DD is the day of the month (01 to 31) 
HH is the hour (military time 0 to 23) 
MM is the minutes  
SS is the seconds 

 
Example set date time command: 
0XDT2005/09/01 13:15:00! 
Sets the date to the 1st of September2005, and the time to 1:15:00 PM. 
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To read the current date and time: 
Send: aXDT! 

 Response: aYYYY/MM/DD HH:MM:SS+q+g 
  

Where the date and time response is the same information as above when setting the date and time. 
q is a single digit that indicates the quality of the time. 0 means the time is invalid. 1 can mean that 
time was set since bootup (if no GPS is present), or that the time has been synced to the GPS in the 
last 12 hours (if a GPS is present). 
g is a single digit that indicates the presence of the GPS. 0 means no GPS is present, 1 means that a 
GPS is present. 

 
Satlink (versions 6.17 and newer) take advantage of this command and set the SDR clock once a day.  
 



4. Practical Applications - Working With Discharge 

What the SDR Can Do For You 
The SDR was specifically designed to eliminate most of the labor involved in working up records from a 
discharge measurement site.  Traditionally, the stage values have been recorded as a line on a strip chart.  
Discharge has been computed by drawing lines to represent the mean daily stage, and then looking up the 
discharge in a rating table or graph.   The SDR eliminates the need for hand computations and data 
recording. 
 
The SDR supports real-time calculation of discharge and daily volume for the following: 

• Parshall flumes 
• Broad-crested weirs 
• Any flow measuring device whose rating takes the form Discharge = A * Stage ^ B, where A and B 

are constants 
• Any site where the relationship between discharge and stage can be represented by a graph of 50 or 

less stage-discharge pairs 
 
You can eliminate the need for after-the-fact hand calculations by: 

• Enabling discharge calculations 
• Entering the coefficients for your flume or weir, or 
• Entering your rating table and selecting the appropriate interpolation technique 

Discharge Setup Sequence 
Very little extra effort is required to make an SDR record discharge as well as stage.  The steps are as 
follows: 

1. Set up stage recording first (Refer to the steps in section 3. Setup and Operation) 
a. Select the recording  interval, 1, 5, 10, 15, 20, 30, or 60 minutes  
b. Select the encoder wheel size, 12 inches, 18 inches, or 375 mm circumference 
c. Set the wheel rotation direction, clockwise positive, or counterclockwise positive 
d. Select the Stage Units, feet, or meters 

2. Calibrate the stage reading so that the SDR stage values match the staff gage for the flume or weir 
3. Follow the steps in the next section to enable discharge recording and set up your flow calculation 

method (equation or table lookup). 

Correctly Recording Discharge 

Enabling The Computation 
 
Discharge calculation can be enabled either from the front panel or from the SDR communicator program on 
your laptop or PDA. 
 
From the front panel, navigate to Station Setup->Discharge.  Once discharge is enabled, the current 
discharge setting will appear on the top menu along with volume information 
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If you are using the SDR Communicator program, select the Setup tab. 
 
 

 
 

Setup Tab in SDR Communicator 
 

Turn on discharge calculation by clicking on the drop-down arrow  in the Discharge Eq. box.  The choices 
are: 
 

• Parshall Flume 
• Weir 
• Generic 
• Dual 
• Rating Table 
• Disabled 

 
Select the type of discharge calculation that you want the SDR to make.  Guidance on making the correct 
selection is provided in the next section. 
 

WORD OF CAUTION 
 

The SDR follows standard computer “execution order” rules when solving the discharge equations.  The 
exponential calculation ( Stage ^ B ) is made first, followed by the multiplication by the constant A.  Rating 
tables (see next page) are computed this way. 
 
(A * Stage) ^ B is NOT the same as  A * (Stage ^ B).   If you are checking  values in a table, or creating your 
own equation by curve fitting values in a table,  be sure to do the calculations in the same order as done by 
the SDR.   

Click here to open 
the drop down and 
select the type of 
discharge 
calculation. 
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Rating Curves and Equations 
 
Every flow measurement site is rated to determine the relationship between the stage at a fixed location (staff 
gage) and the discharge.  The ratings are presented as equations and/or tables that allow the user to determine 
the discharge.  A typical rating table for a weir is illustrated in the figure below. 
 

   State of Colorado    
   Division of Water Resources    
          
Office of State Engineer      Computed by: RVS 
Division 1       Checked by:   RVS 
Rating Table ID:
JUMBOSCO01 

 Jumbo Outlet #1 @ 22.8' 
Weir      

Time of Last Edit: 23-Oct-2002        
    A 73.994      
EQ: Q=73.994(GH)^1.8537  B 1.8537      
           

GH 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09
Feet cfs cfs cfs cfs cfs cfs cfs cfs cfs cfs 

                     
0.00                    

0.10 1.04 1.24 1.45 1.69 1.93 2.20 2.48 2.77 3.08 3.41
0.20 3.75 4.10 4.47 4.85 5.25 5.66 6.09 6.53 6.99 7.46
0.30 7.94 8.44 8.95 9.48 10.02 10.57 11.14 11.72 12.31 12.92
0.40 13.5 14.2 14.8 15.5 16.2 16.8 17.5 18.3 19.0 19.7
0.50 20.5 21.2 22.0 22.8 23.6 24.4 25.3 26.1 27.0 27.8
0.60 28.7 29.6 30.5 31.4 32.4 33.3 34.3 35.2 36.2 37.2
0.70 38.2 39.2 40.2 41.3 42.3 43.4 44.5 45.6 46.7 47.8
0.80 48.9 50.1 51.2 52.4 53.6 54.7 55.9 57.2 58.4 59.6
0.90 60.9 62.1 63.4 64.7 66.0 67.3 68.6 69.9 71.3 72.6

1.00 74.0 75.4 76.8 78.2 79.6 81.0 82.4 83.9 85.3 86.8
1.10 88.3 89.8 91.3 92.8 94.3 95.9 97.4 99.0 101 102 
1.20 104 105 107 109 110 112 114 115 117 119 
1.30 120 122 124 126 127 129 131 133 134 136 
1.40 138 140 142 144 145 147 149 151 153 155 
1.50 157 159 161 163 165 167 169 171 173 175 
1.60 177 179 181 183 185 187 189 191 194 196 
1.70 198 200 202 204 207 209 211 213 215 218 
1.80 220 222 225 227 229 231 234 236 238 241 
1.90 243 246 248 250 253 255 258 260 262 265 

2.00 267 270 272 275 277 280 282 285 288 290 
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The figure illustrates a typical rating table as provided by the State of Colorado’s Division of Water 
Resources.  Note at the top that the rating is for a weir and that the equation upon which the table is based is 
provided.  The type of device, along with the equation, determine how you should set up the SDR.  You may 
choose to enter an equation, or a rating table. 
 
The SDR is designed to support discharge calculations based on the general formula  
 

Discharge = A * (Stage ^ B) 
 

where A and B are constants and ^ represents the operation of raising a number to a power.  The values of A 
and B are determined by the flow measuring device you are using.  Here is how to decide how to set up the 
SDR. 
 

1. Are you using a Parshall flume?  If so, select Parshall Flume as the discharge calculation type. 
2. Are you using a weir?  Examine the coefficient B in the equation.  If the coefficient is EXACTLY 1.5 

or 3/2, then select Weir as the calculation type.   
3. If you are not using a Parshall Flume or weir, or the B coefficient is NOT 1.5, then select Generic as 

the calculation type. 
 
In the example table above, the device type is weir, and the equation is: 
 

Q=73.994 * ( (GH)^1.8537 ) 
 
Note that since the B coefficient is 1.8537 the correct calculation type for the SDR will be Generic, and NOT 
Weir.  This is because the B coefficient is NOT 1.5. 
 
The following paragraphs provide additional information on how the SDR computes discharge for the 
different calculation types. 

Parshall Flume 
 
Parshall flumes are one of the most widely used discharge measuring devices in the world.  The SDR uses 
the following equation family to compute the discharge for Parshall flumes: 
 
 

W, in feet Discharge equation, Q in CFS

0.25 (3 inches) Q = 0.992 H ^ 1.547 
0.5 (6 inches) Q = 2.06 H ^ 1.58 

0.75 (9 inches) Q = 3.07 H ^ 1.53 
1 to 8 Q = 4W H ^ (1.522 W ^ 0.026)

10 to 50 Q = (3.6875W + 2.5) H ^ 1.6 
 
(Reference:  Open Channel Hydraulics, Chow, Ven Tee, McGraw Hill Book Company, New York, 1959) 
 
If you are using a Parshall flume you will only have to enter the throat width, W.  The SDR will compute the 
appropriate values for A and B in the discharge equation.  Note that these equations DO NOT account for 
submerged outlet conditions. 

Weir 
 
Weirs are also widely used for discharge measurement, but, unlike Parshall flumes, are not standardized.  
There is an infinite variety of widths, side shapes, and constructions.  In general, the discharge over a weir 
can be represented by the equation: 



 
Discharge = K * L * ( Stage ^ (3/2) ) 

 
where K is a coefficient determined by the rating process, and  L is the length of the crest.  Examine the 
rating equation for your weir carefully.  Some weirs will provide the coefficient K and some will provide the 
product K * L.  You will need the PRODUCT,  K * L to enter as W in the SDR.  For example, if the weir 
equation is given as: 
 

Q=73.994 * ( (GH)^1.5 ) 
 
then you would enter 73.994 for W in the SDR. 

General-Purpose Equation 
 
The general purpose equation should be used for any non-standard flume or weir.  As long as the device 
rating can be expressed in the form: 
 

Q=A * ( (GH)^B ) 
 
then the SDR can be used to compute the discharge.  For example, from the rating table presented earlier we 
were given the discharge equation: 
 

Q=73.994 * ( (GH)^1.8537 ) 
 
Enter the value 73.99 for A in the SDR and 1.8537 for B.  The procedures for entering coefficients into the 
SDR are given in the next section. 

Entering the Coefficients 
 
The flume and weir constants are entered after you make your selection for the computation type (Parshall 
Flume, Weir, Generic).   
 
If you are setting your SDR up from the front panel, the coefficient entry is “context sensitive.”  That is, the 
SDR will determine what you need to enter.  
 
 If you select Parshall Flume as the device type and scroll down one position you will see the prompt 
“Parshall Flume Width”, followed by a value.  Press the SET key to change the width.  When you press SET 
you will see the prompt “Change width”, followed by the current value.  Use the UP/DOWN arrow keys to 
scroll through the available widths.  (Newer SDRs will allow you to enter non-integer values for the width.) 
 
If you select Weir as the device type and scroll down one position you will see the prompt “Weir Coefficient 
W”.  Press the SET key to change the value.  Note that W represents the K*L product in the general weir 
equation.  When you press SET you will see the prompt “Change Weir Coefficient W”, followed by a value 
containing a blinking cursor.  Use the arrow keys to position the cursor and to scroll the individual digits.  
Press SET to make the coefficient permanent after you are done editing. 
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If you select Generic as the device type and scroll down one position you will see the prompt “Coefficient 
A”, followed by a value.  Press SET to change the value.  You will see the prompt “Change Coefficient A”, 
followed by a value containing a blinking cursor.  Use the arrow keys to position the cursor and to scroll the 
individual digits.  Press SET to make the coefficient permanent after you are done editing.  Press the down 
arrow key after Setting the value of Coefficient A.  You will see the prompt “Coefficient B”, followed by a 
value.  Press SET to change the value.  You will see the prompt “Change Coefficient B”, followed by a value 
containing a blinking cursor.  Use the same procedures you used to set and store Coefficient A. 
 
Setting the coefficients with the SDR Communicator program is even easier.  The three figures below 
illustrate the Setup tab and the screen appearance with Parshall Flume, Weir, and Generic selected as the 
device type.  Note in each case that the screen is case sensitive and will only allow you to enter the 
appropriate coefficients. 
 
 
 

 

Only width is 
required for 
Parshall Flume 

 
Setup Tab with Parshall Flume Selected 
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Weir requires 
entry of W 
(the  K*L 
product)  

 
Setup Tab with Weir Selected 

 
 

  

Generic requires 
both the A and B 
coefficients 

 
Setup Tab with Generic Selected 
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Dual Sensor Discharge Equation 
If the secondary sensor is enabled, a new type of discharge equation becomes available.  Please see section 
Appendix I – Dual Sensor on using dual sensors.   The dual sensor discharge equation uses two sensors to 
compute the discharge.  Stage one is the downstream sensor.  Stage two is the upstream sensor.  Water flows 
by the upstream sensor before it flows by the downstream sensor. 
 
Dual sensor (submerged orifice equation) : 

Q = Cd* A √(Hu-Hd)G 
Q is the computed discharge. 
Cd is the discharge coefficient which can be changed by the user in discharge setup.  0.6 is a 

generic value for a slide gate. 
Hd is the downstream water level (Stage) 
Hu is the upstream water level (Stage Two) 
G is 32.175 ft/sec/sec (constant and not changeable) 
A is the gate area opening that is setup by the user.  

For the SDR, the gate area is fixed and entered by the user in discharge setup.   

Rating Table Lookup 
Rating table lookups have been added with SDR version 3.03 and higher.  The rating table method should be 
used for natural stream channels, or when the other discharge equations are insufficient.  Rating tables are 
specific to sites and must be developed using standard stream gauging techniques.  A rating table contains 
pairs of entries.  A pair consists of the stage and the discharge that corresponds to the stage.  Here is an 
example of a rating table: 
 

Stage Discharge 
0.25 3.66 
0.50 4.67 
1.25 9.70 
1.50 12.38 
1.75 15.80 
3.50 87.07 
4.25 180.92 
5.00 375.88 

 
 
Selecting Rating Table As The Discharge Calculation Method 
To choose Rating Table as the discharge calculation method, first make sure discharge calculations are 
enabled (Station Setup -> Discharge).  Then choose Rating Table as the discharge equation setting (Station 
Setup -> Discharge -> Discharge Equation).   Rating table options are selected in the Discharge tab of 
SDRComm, as shown here: 
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Entering The Rating Table Into The SDR 
You may enter tables with up to 50 point pairs into the SDR.  You can enter the table from the front panel, or 
you can enter it using SDRComm. It is much easier to use SDRComm. 
 
First, use NOTEPAD or WORDPAD on your PC or laptop computer to create a .txt file in “comma-
separated variable” format.  The table above looks like this when entered correctly: 
 
0.25,3.66 
0.50,4.67 
1.25,9.70 
1.50,12.38 
1.75,15.80 
3.50,87.07 
4.25,180.92 
5.00,375.88 
 
 
Send the rating table file to the SDR by pressing the Send Table button in the Discharge tab, as illustrated 
here. 
 

 

Choose the 
Rating Table 
interpolation 

Click to send a 
file with the 
rating table to 
the SDR 

 
Rating Table Discharge Setup 

 
You will see the following Explorer window when you press the Send Table button.  Use it to locate your 
rating table and send it to the SDR by pressing the Open button. 
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Selecting The Interpolation Method 
Most of the time, the stage measured by the SDR will not exactly match a stage in the table.  The SDR will 
interpolate discharge values, based on where the measured stage is in relationship to the stage values in the 
table. 
 
The SDR offers several interpolation methods, and it is important to select the correct one for your table.  
The SDR offers several interpolation methods:  

• linear 
• log–linear (log stage, linear discharge) 
• linear–log (linear stage, log discharge) 
• log-log 
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The best way to select the interpolation method is to enter your table into Excel and make three graphs.  The 
first graph should be of the stage and discharge, exactly as in the table.  The following graph illustrates the 
data from the example table given earlier. 
 

Discharge versus Stage
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Note that there are wide gaps between the values and that a straight line interpolation would probably give 
values that are too large – particularly between 1.5 and 3.5 feet of stage. 
 
Next, plot the logarithm of the discharge versus the stage.  That looks like this: 
 

Discharge versus Stage

y = 0.4235x + 0.4576
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The stage-discharge relationship in the example table is a perfect straight line when plotted this way.  As a 
result, you would select Linear-Log as the interpolation method. 
 
Here is the log of the discharge plotted versus the log of the stage. 
 

Discharge versus Stage
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This plot indicates that Log interpolation would be better than Linear interpolation, but not as good as 
Linear-Log.  Had this graph been a straight line, or near straight line, you would chose Log as the 
interpolation type. 
 
You will almost never use Linear interpolation or Log-Linear in real-world situations.  If you have to guess, 
use Linear-Log or Log.  The reason for this is that most real world streams show a large increase in 
discharge for relatively small increases in stage.   
 
The type of interpolation is less critical if your table has a lot of closely spaced points.  That being said, you 
are still always better off to plot the table values and use the best method, as indicated by the shape of the 
three plots. 
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5. Installation 

Site Installation 
The SDR has been designed to minimize the amount of time needed to set it up. Setup can be done directly 
from the front panel, or, through the SDR communicator program running on a PC or PDA. Here are some 
guidelines to follow when installing the SDR: 
 
1. Make sure you have a float, tape or beaded wire, counterweight, and pulley.  These items are sold 

separately by Sutron.  The pulley should have an insulating hub or use a plastic/PVC float for maximum 
lightning protection. 

2. The SDR is intended for installation on top of a small stilling well.  The minimum well size is 6 inches 
in diameter.  You will also need a small protective cover to protect the SDR from the environment. 

3. Secure the SDR to a level base, using the four screw holes in the mounting feet.  Use washers as shims, 
if necessary, to level the SDR.  If you are using an 18” float wheel, you may need to cut a slot in the 
mounting surface to allow the wheel to rotate freely. 

4. Connect the SDR to a suitable battery.   Use either a 12V battery or two six-volt batteries in series.  Use 
the crimp type fasteners provided with the SDR or other means to make sure the battery connections are 
firmly attached to the wire. 

5. Configure the SDR for the specific needs of the site, this includes such items as: 
• Station name and desired time. 
• Measurement interval 
• Wheel size 
• Ensure the direction of rotation is correct  
• Enable/Disable Discharge and, if enabled, discharge calculations (parshall flume, weir, or generic 

equation) 
• Calibrate the current stage 
• And finally, enter a password if one is needed 

6. Ensure the green led is flashing and that the current stage is correct before leaving the site. 
 
Note: If the red led is flashing, it is an indication some user action is needed.  The display will indicate the 
required action when the display is turned on or turned off. 
 

Leveling the SDR 
Secure the SDR to a level platform with either four wood screws or the appropriate bolts, nuts, and lock 
washers. Four #10-32 mounting holes are provided for mounting feet or bolts, if additional leveling is 
required. 
 

Grounding the SDR 
Run a short #12-14 solid copper ground wire between the ground lug on the side of the SDR and an earth 
ground.   

 

Connecting the Battery 
The SDR uses two terminals for power, one labeled Power In, and the other is shared with the SDI-12 
connections. This allows replacement of a low battery without interrupting   The SDR is designed to operate 
from 5.5V to 16VDC using a variety of batteries.    The following table shows the battery life for several 
common types of batteries. 
 
12V 7 Amp-hr gel cell (NP7-12) --  4 months @ 20 C,  3 months @ 30 C 



12V 12 Amp-hr gel cell (NP12-12) --  6 months @ 20 C,  5 months @ 30 C 
12V 17.2 Amp-hr gel cell (NP18-12B) - 8 months @ 20 C, 7 months @ 30 C 
12V 24 Amp-hr gel cell (NP24-12B)- 11 months @ 20 C, 9 months @ 30 C, 7 months @ 40 C 
12V Alkaline (two 6V Lantern (Eveready 528 or 529) in series) - 15 months  
12V Alkaline (eight D cells (Duracell MN1300) in series) - 9 months 
12V Alkaline (eight C cells (Duracell MN1400) in series) - 5 months 
7.5V Alkaline (Eveready EN715 industrial battery) - 12 months 
 
 
 
Single +12 Volt Connection: 
 
 
 
 
 
 
 
 

 
Two +6 Volt Batteries (Series connection): 
 
 
 
 
 

 
 
 
 
 
 
 

 

 

+ 
 

+12 Volt 
Battery 

 
- 

SDR 
+ 
 
- 

+ 
 

+6 Volt 
Battery 

 
- 

SDR 
+ 
 
- + 

 
+6 Volt 
Battery 

 
- 

Wire negative ( - ) of battery 
one, to Positive ( + ) of 
battery two. 
Wire Positive of Battery one 
to SDR +, and negative of 
battery two to SDR -. 

1 

2 

 

Installing the float wheel/pulley 
The SDR is compatible with 5/16” shaft float pulleys/wheels with a circumference of 12 inches, 18 inches or 
375 mm.  You may use wheels designed to work with either beaded wire or punched steel tapes.  Any wheel 
used should have an insulating hub in order to protect the unit from lightning.  Most wheels attach to the 
shaft using an Allen screw. Attach the float and counter weight to the tape or beaded wire per the 
instructions provided. Set both the float and counter weight into the stilling well and mount the tape/beaded 
wire onto the wheel. 
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Checking the direction of rotation 
Rotate the shaft to see if the direction of rotation is set properly (I.E. when float rises, level increases).  If the 
level does not change as desired, either turn the tape around (put the float on the other side of the wheel) or 
use the setup menus to change the direction of rotation. 
 

Calibrating the Stage value 
Once the unit is secured, and all of the parameters are configured, the stage must be calibrated (set).  This is 
done from the Stage display in the main menu.  Simply go to the Stage display and press SET.  Use the 
arrow keys to change the value for the stage and press SET again or CANCEL. 



6.  Maintenance 

The SDR is designed to operate for extended periods with very little or no maintenance required. If a site 
visit is needed for any reason, it is a good idea to perform a routine maintenance check of the encoder. Some 
easy to follow guidelines are listed below. 
 

1. Perform a visual inspection of the unit. Note any abnormalities such as external oxidation, rust. 
 

2. Check the wiring to make sure it is not corroded, frayed, or loose. 
 

3. Press any button to turn on the display.  Once the stage reading is shown, verify the reading matches 
the staff gauge installed at the site. 

 
4. Download the data and events.  Examine the log for any abnormal readings or events. 

 

Troubleshooting Common Problems 
 

1. Unit will not power on. 
a. Verify power with a multimeter directly on the terminal block screws. A common issue is 

the terminal block has been tightened onto the wire insulation, instead of the conductor.  
2. Display backlight turns on, but no menus are visible. 

a. Adjust the contrast until the menus are readable. 
3. SDI-12 communications do not work. 

a. Check wiring to data recorder, including power connections and SDI-12 Data line 
b. Check the SDI-12 address and make sure the data recorder is set the same as the Water 

Monitor.  
c. If multiple SDI-12 sensors are connected, verify each sensor has a unique address. 

4. RS-232 communications do not work with a terminal program. 
a. Verify the terminal settings (115200, 8,N,1) and that the terminal program is set to the 

correct com port of the pc/laptop. 
b. Verify the Water Monitor has not been configured for MODBUS. 

5. The Water Monitor does not track the observed readings. 
a. Check the setup for a wrong wheel size, or if using analog, for wrong slope/offset. 
b. Check the rotation direction for wheel is set correctly. 
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Appendix A – Specifications for SDR 

Input Voltage 5.5 to 16 VDC reverse voltage protected 
Power Consumption < 2.5 mA @ 12 VDC 
Starting Torque < 0.25 inch-ounce 

Shaft Diameter 5/16 inch with both threads and a flat 
Rotation Resolution 400 count per revolution 
Range +/- 80 ft of the set value 
Display 2 line, 20 character per line with backlight 
Bearing Supports Double bearing arrangement supports up to 10 lb. shaft load 
Supported Wheels 12”, 18”, 375mm circumference 

Supported Units Feet, Meters 
Maximum Rotation Speed 5.5 rev/s 
Log Capacity Over 300,000 readings 

Discharge Calculations Parshall Flume, Weir (w*Stage^1.5), Generic (A*Stage^B), 
Dual Sensor, Rating Table 

  

 

Ordering Information 

Part Number Description 

SDR-0001-1 SDR with 400-count optical shaft encoder, no pulley  

SDR-0001-3 SDR with expanded analog input options, including 4-20mA 
output, without a shaft encoder. 
 

SDR-0001-4 SDR with both shaft encoder and expanded analog input 
options, including 4-20mA output. 
 

 



Appendix B – Connector Pins 

DB9 Connector 
The SDR comes with a DB9F connector for connection to RS-232 devices.  The DB9F can be connected to 
the serial port on most PCs using a straight cable.  A null modem adapter is needed to connect to most PDAs.  
The following table shows the pin assignments in the DB9F connector. 
 

DB9F Pin Name Notes 
1 N/C No Connection 
2 RXD Data from SDR 
3 TXD Data to the SDR 
4 DTR Signal to the SDR 
5 Ground  
6 N/C No Connection 
7 RTS Request to Send, signal to the SDR 
8 CTS Clear to Send, signal from the SDR 
9 VOUT Jumper selectable for 5V or VBAT (100ma max) 

 

Terminal Block  
 

Terminal Block Description Notes 
1 BAT G Battery Ground (-) 
2 BAT + Battery + 
3   
4   
5 SDI G Also can be used for Battery Ground 
6 SDI + Also can be used for Battery + 
7 SDI D  
8 Shield  
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Appendix C – Sutron Customer Service Policy 

CUSTOMER SERVICE POLICY 
 
 

Dear Customer:  

Thank you for making the important decision to purchase Sutron equipment. All 
Sutron equipment is manufactured and tested to the highest quality standards as set 
by Sutron’s Quality Assurance Department. Our Customer Service Representatives 
have years of experience with equipment, systems, and services. They are electronic 
technicians with field and applications experience, not just with a technical 
background.  

Customer Phone Support 
Customer Service Representatives routinely handle a wide variety of questions every 
day. If questions arise, please feel free to contact me or one of the Customer Service 
Representatives. We are available from 8:00 am to 5:00 pm Monday through Friday 
and will be happy to take your call. 
 
We can answer most sensor and interface questions on the first call. If we cannot 
quickly answer a question on an interface, we will work with you until we find a 
solution. 
 
Sometimes a problem is application related. Although we pride ourselves on handling 
95% of application related questions over the phone, we maintain constant contact 
with our Integrated Systems Division and Engineering Division for additional 
assistance.  

Introductory Training  
Training is an important part of the Sutron Customer Service philosophy. The Sutron 
training policy is simple---If you buy Sutron equipment, you get Sutron training! 
Without the proper training, you cannot take advantage of the benefits and 
advantages that Sutron equipment provides. We often supply on-site introductory 
training at your facility for no charge. You provide the classroom, students, 
equipment, and coffee---we'll provide the instructor.  

On-Site Visits 
Of course not all problems can be fixed over the phone. Sometimes a customer needs 
an on-site technician to identify site related problems or troubleshoot a network. 
Sutron can provide these services at a reasonable cost. Call for details. If you would 
like to learn more about Sutron products email sales@sutron.com 
 
Thanks again for your order, 
 
Paul Delisi 
Customer Service Manager 
Sutron Corporation 



Appendix D – Commercial Warranty     

SUTRON MANUFACTURED EQUIPMENT 
THE SUTRON CORPORATION WARRANTS that the equipment manufactured by its manufacturing 
division shall conform to applicable specifications and shall remain free from defects in workmanship and 
material for a period ending two years from the date of shipment from Sutron’s plant. 
  
Sutron’s obligation under this Warranty shall be limited to repair at the factory (21300 Ridgetop Circle, 
Sterling, VA 20166), or at its option, replacement of defective product. In no event shall Sutron be 
responsible for incidental or consequential damages, whether or not foreseeable or whether or not Sutron has 
knowledge of the possibility of such damages. This warranty shall not apply to products that have been 
damaged through negligence, accident, misuse, or acts of nature such as floods, fires, earthquakes, lightning 
strikes, etc.  
Sutron’s liability, whether in contract or in tort, arising out of warranties or representations, instructions or 
defects from any cause, shall be limited exclusively to repair or replacement parts under the aforesaid 
conditions.  
Sutron requires the return of the defective electronic products or parts to the factory to establish claim under 
this warranty. The customer shall prepay transportation charges to the factory. Sutron shall pay 
transportation for the return of the repaired equipment to the customer when the validity of the damage claim 
has been established. Otherwise, Sutron will prepay shipment and bill the customer. All shipments shall be 
accomplished by best-way surface freight. Sutron shall in no event assume any responsibility for repairs or 
alterations made other than by Sutron. Any products repaired or replaced under this warranty will be 
warranted for the balance of the warranty period or for a period of 90 days from the repair shipment date, 
whichever is greater. Products repaired at cost will be warranted for 90 days from the date of shipment.  
 

NON-SUTRON MANUFACTURED EQUIPMENT 
 
The above Warranty applies only to products manufactured by Sutron. Equipment provided, but not 
manufactured by Sutron, is warranted and will be repaired to the extent of and according to the current terms 
and conditions of the respective equipment manufacturers. 
  

REPAIR AND RETURN POLICY 
 
Sutron maintains a repair department at the factory, 22400 Davis Dr #101, Sterling, VA 20164. Turn around 
time normally ranges from 10-30 days after Sutron receives equipment for repair. Call Customer Service at 
(703) 406-2800 for a Return Material Authorization (RMA) number. Return the defective equipment to 
the factory, transportation charges paid. 
  

EXTENDED WARRANTY AND ON-SITE MAINTENANCE 
Extended warranty and on-site maintenance contracts are available. Price quotations may be obtained from 
Sutron customer service representatives. 
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Appendix E – Analog Option SDR-0001 -2, -3  and -4 

 
The Stage-Discharge Recorder (SDR) model numbers SDR-0001-2, SDR-0001-3, and SDR-0001-4 are 
modified versions of the standard SDR recorder that include the addition of a special analog input card 
located on the end panel of the SDR.  The main feature of this option is to allow the SDR to use other 
various types of sensors.   
SDR-0001-2 has an analog input board, while the SDR-0001-3 has an expanded analog input board that 
includes an 4-20mA output.  Neither  the -2 nor the -3 have the shaft encoder. 
The SDR-0001-4 includes expanded analog input board that includes an 4-20mA output and the shaft 
encoder. 
 
Starting with software version 3.00, SDR can collect data from two stage sensors.  Any two inputs may be 
used.  One option is to setup two analog inputs; another is to setup one shaft encoder input and one analog 
input. 
 

 
 

Types Of Sensors that may be used to calculate Stage: 
 

• Pressure (level) sensors.  Pressure sensors have several advantages over shaft encoders in some 
installations and a pressure sensor, such as a Druck, can be either a 4 wire bridge type or a 4-20ma 
type. 

• Ultrasonic type water level sensors with 4-20ma Output.  The SDR supports ultrasonic type such as 
Flowline ordered with 4-20ma outputs. 
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• Any other 0-5 Volt analog type sensors, such as a potentiometer, may be used in the general analog 
input class. 

 
Any of the above mentioned sensors or other analog level sensors may be used with the SDR in order to 
calculate the stage.  The sensor will use a slope and offset to convert the electrical reading into a stage level. 

Differences Between the -2 and the -3 SDR Analog Option: 
 
The SDR may be ordered with two analog option versions.  They are as follows: 

SDR-0001-2: SDR w/ Voltage and 4-20mA INPUT. (single row terminal) 

 
 
Terminal Block (UPPER)  
Note the circled areas.  These circled areas are intended to assist the user in connecting a sensor to the proper 
group of wires.  The section below will help define the input types. 
 
 

Terminal Block Description Notes 
1 AGND Analog Ground  
2 Analog 0-5V ‘A’ Voltage input for stage sensors with 0-5V output
3 Analog 0-5V ‘B’ Voltage input for stage sensors with 0-5V output
4 AGND Analog Ground 

5 VREF 2.5V output which is turned on during warmup 
and analog sensor measurement 

6 DIFF ‘C’ (+) Differential Voltage Input for Bridge type 
sensors 

7 DIFF ‘C’ (- )  

8 DIFF ‘D’ (+) Differential Voltage Input for Bridge type 
sensors 

9 DIFF ‘D’ (- )  
10 24V (4-20ma) 24 Volt output for 2 wire 4-20ma sensor 
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11 I-Input (4-20ma) Current input for 2 wire 4-20ma sensor 
12 Counter Input Future Support 
13 Gnd Digital Ground 

14 SW’D Batt Switched Battery (turned on during warmup and 
analog sensor measurement) 

 
 

SDR-0001-3 SDR w/Voltage and 4-20ma INPUT and 4-20ma OUTPUT.  
(Dual Row Terminals) 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Terminal Block (UPPER)  
 
Note the circled areas.  These circled areas are intended to assist the user in connecting a sensor to the proper 
group of wires.  The section below will help define the input types. 
 
 
 

Terminal Block Description Notes 

15 4-20ma Output (+) Connect 2 wire ‘VOLTAGE’ wire here (eq. 24 
Volts) 

16 4-20ma Output (-) Connect 2 wire ‘-‘ terminal here 
17 GND Digital Ground 

18 DIFF ‘E’ (+) Differential Voltage Input for Bridge type 
sensors 

19 DIFF ‘E’ (- )  
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20 I/O ‘A’ Future Support 
21 I/O ‘B’ Future Support 
22 GND Ground 

 
SDR-0001-4 SDR w/Voltage and 4-20ma INPUT and 4-20ma OUTPUT 
and SHAFT ENCODER 
 
This model of the SDR includes both the shaft encoder and the expanded analog board with the 4-20mA 
output.  It’s analog inputs are identical to the SDR-0001-3. 
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Analog Input Types Found on both -2 and -3 Analog Versions 
 

Single Ended Input Voltage (0 to 5 Volts) 
 
This input is designed to be a general purpose 0-5 volt dc input.  While sometimes referred to as a single 
ended input, it is designed to measure voltage with respect to analog GROUND.   This input has a high 
impedance (>2 Meg Ohms) and will not load down or draw significant current.  Two inputs are labeled 
"Analog 0-5V "on the panel, they are ‘A’ and ‘B’, although the current SDR software will only measure and 
support the Analog “A” input. 
 

Analog 
Sensor 
(0-5v) 

SDR with Analog 
Input Option. 
 
       1     2 

Gnd 

Gnd 

 
 
 
 
 
 

     VALID INPUT RANGE  0 to 5 Volts. 
 
 
 
 
When the measurement type "Analog A 0-5" is selected, the system will make a voltage reading from the 
sensor connected on the input labeled Analog "A".  It will then apply the user entered SLOPE and OFFSET 
to convert the voltage reading to a stage level by applying the following equation: 
 

Stage = (Voltage * SLOPE) + OFFSET 
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Differential Input Voltage (+/- 39mV range) 
 
This input is designed to operate with a special type of analog output found on many pressure sensors that 
use a “bridge” configuration or any sensor that outputs a very small voltage.  This input type has a “+” and “-
“ input that connects to the sensor output.  Two inputs are labeled "Diff" on the panel, they are ‘C’ and ‘D’, 
although the current SDR software will only measure and support the Analog Diff “C” input. 
 
Typically in a bridge sensor, the sensor will be powered from the “VREF” output also called Excitation in 
the pressure sensor manuals, have a "signal +" and "signal -" and the 4th wire for the analog ground. NOTE: 
If after wiring the sensor, it displays a negative reading, you may reverse the “+” and “-“ leads coming from 
the sensor. 
 
 
‘BRIDGE’ type SENSOR 
 
 
 
  

   

Excitation 
(VREF) 

Analog 
Gnd 

_ 

+

SDR with Analog 
Input Option. 
 
 
      4      5     6      7 

 
 
 

 
VALID INPUT RANGE +/- 0.0390625 Volts     (ACROSS THE + and – INPUTS) 

 
 
The returned reading will be in Volts; it ranges from -0.0390625V to +0.0390625V.  This applies if the 
Slope = 1 and the offset = 0. 
 
The system will make a reading of the voltage across the + and – inputs labeled for the “Diff C” input. It will 
then apply the user entered SLOPE and OFFSET to convert the voltage to a stage level by applying the 
following equation:  
 

Stage = (Voltage* SLOPE) + OFFSET 
 
 
NOTE: The common mode voltage for differential sensors is 0.5V to 3.7V.  If the sensor is floating, it 
should be tied to VREF and not to AGND in order to maintain this common mode voltage.  
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4 to 20 ma Current Loop Input 
 
This input is designed to function with sensors that have a 4 to 20ma current loop interface.  This type of 
interface is superior to voltage outputs when the cables to the sensors must travel a long distance or when the 
equipment is located in electrically noisy environments.  The current required for the sensor is provided by 
the 2 wire loop and does not typically require additional connections.  The SDR analog card has a 24 Volt 
supply that is designed just for the 2 wire interface 4-20ma loop. 
 
    
 
 
     SDR with Analog Input 

Option. 
 
          10      11 
          24 v    I-In 

4-20 
ma 
Sensor 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  VALID INPUT RANGE  4 to 20 mA 
 
 
 
 
This SDR analog input will measure the current flowing when connected to the ‘4-20ma Input’.  Typical 4-
20ma sensors will give a 4 to 20ma current for a 0 and 100% FS.  Readings that are greater than 21mA will 
be considered a fault by the SDR. 
 
 The SDR will convert the 4 to 20ma readings from ‘ma’ to ‘stage’ by using the slope and offset fields by 
applying the following equation:  
 

Stage = (current * SLOPE) + OFFSET 
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Additional Menu Items to Support Analog Input Sensors: 
An SDR with an analog expansion board will have a slightly different Station Setup menu structure.  It will 
offer additional options for setting up the analog sensor(s): 
 
Station Setup 

Measurement Setup 
Stage Sensor 

Sensor Type 
Analog Warmup  
Slope         
Offset         
Averaging Time 
Test Sensor        

Second Sensor 
Sensor Type 
Analog Warmup 
Slope 
Offset 
Averaging Time 
Test Sensor 

Sensor Type 
This field will allow the choice of several analog inputs.  Please choose the input appropriate for your sensor 
(see section above).  Note that the selection will determine both the input connector and the sensor type.  
These options are available: 

• Analog A 0-5V 
• Analog 4-20mA 
• Analog Diff C 
• Analog B 0-5V  
• Analog Diff D 
• Analog Diff E 

 
Once an analog the sensor type is selected, proceed to setup the following fields. 

Sensor Warmup 
This time field will determine how long in advance of the reading the Switched Battery is turned on.  This 
also controls the VREF (2.5 volts) output.  Provide enough warmup time to make a good reading from the 
sensor without wasting too much time and battery power.  Warmup time is sensor specific. 
 

Slope 
Enter a value for the slope as required to convert volts, milliamps, or ratiometric values into numbers that 
represent stage in feet or meters.  Positive and negative values may be entered.  Simply toggle the “+” sign to 
a “-“ sign when entering the value. 
 

Offset 
This offset, when combined with the slope above, will complete the conversion of physical readings to 
STAGE level.  Positive and negative values may be entered.  Simply toggle the “+” sign to a “-“ sign when 
entering the value. 
 

Averaging Time 
The SDR can be setup to do simple averaging, meaning that it will collect data the user specified amount of 
time.  Once the time is up, it will sum up all the samples and divide the sum by the number of samples 
collected.    Averaging time should be used for noisy sensors and for choppy water surfaces. 
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If averaging time is zero (which is the default), no averaging is done.  If it is not zero, the unit will collect 
data for however long the averaging time is setup for.  The value can be set anywhere from 0 seconds (no 
averaging) to 900 seconds (15 minutes).   
 
Please note that the Stage readings on the front panel will only update as fast as the averaging interval.  
That means that if the averaging time is set to 10 minutes, the display will update only once every 10 
minutes!   
 
 

Additional Setup Comments: 
 

• When the shaft encoder is installed and selected for operation, the menu fields for the Analog 
options are not visible.  Conversely, if the Analog inputs are selected, the shaft encoder menu fields 
are not visible. 

• Slope and Offset values must be entered in the SDR setup fields as they are extremely important in 
converting the reading into a STAGE value, which is the ultimate goal of the SDR and that is what 
is logged.  Consult the Connecting Sensors to verify that he sensor is connected properly, and 
equally important, configured properly. 

• There is a ‘Sensor test’ menu at the bottom of the Sensor Setup menu.  Pressing SET in this menu 
will cause the SDR to measure the analog sensor and report both the raw voltage provided by the 
sensor, and the completed measurement result (which is the raw voltage with the slope and offset 
applied).  In addition, the warmup time will be tested to make sure it is adequate (it is tested by first 
turning off VRef and Switched Battery, waiting a while and then applying power to the sensor for 
warmup time). 

• Once the system is properly setup and installed in the field application, the “Calibration” process 
must be executed as described in page 10 of this manual. 

 
 
 
 
 
 
 



Example Analog Sensor Setups 
 

 

SENSOR 1:    ‘DRUCK’ Pressure Sensor (10 PSI range) 
 
The DRUCK TM brand of pressure sensors is a common alternative to the shaft encoder type of application.  
This application note will show operation using the DRUCK model PDCR 1830. 
 
This sensor is a bridge sensor that is designed to be driven by a voltage, VREF in this case, and the output of 
the bridge is a differential reading that will have a full scale output that is 1/10th of the VREF.  Since VREF 
is 2.5 volts, the Full Scale, or FS output of the sensor will be 25 mv.  Since the Differential Input Range is 
39.0625 mV, then the 25mV FS of the sensor is always within range. 
 
The nature of the bridge sensor will automatically place the differential reading in the allowable common 
mode range of the Differential input and in this case, in the ballpark of 1.25 volts. 
 
Connect the sensor as follows: 
 
 
 
 
 
 
  

   

Excitation 
(VREF) 

Analog 
Gnd 

_ 

+

SDR with Analog 
Input Option. 
 
 
      4      5     6      7 

 
 

Terminal Block Description DRUCK Pin Description COLOR 
3    
4 AGND Negative Supply WHITE 
5 VREF Positive Supply RED 
6 DIFF ‘C’ (+) Positive Output YELLOW 
7 DIFF ‘C’ (- ) Negative Output BLUE 
8    

 
 
NOTE:  Connect the shield wire on the DRUCK to the earth ground on the side of the SDR. 
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SDR SETUP CONFIGURATION 
 

• In the menus, select the “Analog DIFF C” sensor. 
• Set warmup time to 500 ms. 
• Set slope to 922.92 
• Set offset to 0.0 
• Set units to Feet. 

 
The slope is calculated as follows:   
(10 PSI / 25 mV) * (1000 mV / 1 V) * (2.3073 feet / PSI) = 922.92 feet / V 
 
Take measurements and confirm operation.  Executing a ‘calibration’ will allow the level to be adjusted to 
match a staff gauge if available. 
 
 
 

SENSOR 2:    FlowLine Ultrasonic Sensor (4-20ma sensor)  
 
 
The Flowline brand of ultrasonic sensor is designed to output a 4 to 20 ma current output that is proportional 
to 0 and Full Scale range of the sensor.  This example will be worked with the Flowline Model LA15. 
 
The output range is 3.6 inches to 6 feet (72 inches). 
 
 
 
     
 FLOWLINE LA15 
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   12-36 Volts 
 
   GND 

SDR with Analog Input 
Option. 
 
          10      11 
          24 v    I-In 

4-20 
ma 
Sensor 

 
 
 
 
 
 
 
 
 

Terminal Block Description Flowline Pin Description COLOR 
10 24V (4-20ma) 12-36 Volts DC na 
11 I-Input (4-20ma) GND na 

 
 



SDR SETUP CONFIGURATION for FLOWLINE type sensor (for readings in feet) 
 
As this sensor reads distance from sensor to water, using the settings below will reverse that direction 
providing values that fall when the water level falls.  All that is required is to perform a stage calibration 
following this setup. 
 

• In the menus, select the “Analog 4-20ma” sensor. 
• Set warmup time to 20,000 ms.   (20 Seconds) 
• Set slope to  + 0.35625   
• Set offset to +0.00 
• Set Units to Feet 

 
Take measurements and confirm operation.  Executing a ‘calibration’ will allow the level to be adjusted to 
match a staff gauge if available. 
 
Note that the Flowline sensor takes about 20 or more seconds or so to make a stable reading.  This example 
shows 20 seconds for warmup. 
 
General Transfer Function for Flowline LA15:  Note:  This is the distance from sensor to water height, so as 
water falls, the sensor reads higher values.   
 
  

Transfer Function for Flowline LA 15

y = -0.35625x + 7.42500
R2 = 1.00000
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4-20mA Output 
SDR-0001-3 and SDR-0001-4 (which feature the expanded analog option board with the 4-20mA output) 
running software version 3.02 or newer can express the current reading via the 4-20mA output.  That means 
that the SDR will output a current that corresponds to either stage, stage two, discharge, or volume.   
 
An external device needs to be connected to pins labeled ‘4-20ma output’ (pins 15 and 16) of SDR’s analog 
option board.  That device will provide power to the SDR (8V to 36V) and read the value output by the 
SDR.  As long as the external device is proving power to the SDR, the SDR will output the proper current on 
the loop.  How often the SDR updates that current to match the stage reading is based on the Update Interval 
(see below). 
 
Settings that control 4-20mA output behavior can be found via the front panel under:  

Station Setup -> Other Setup -> 4-20mA Output 
 
4-20mA output behavior is controlled by these settings: 

• 4-20mA Out Enable (default disable)  
• 4-20mA Out Source (default Stage)  
• EGU Hi (default 10, 2 right digits)  
• EGU Lo (default 00, 2 right digits)  
• Update interval (express in seconds, default to 1.0 seconds)  

 
If 4-20mA output is enabled, the SDR will periodically update the current output on the 4-20mA circuit.  
How often the current is updated to match the stage reading depends on the user setting Update Interval.  
The device reading the 4-20mA circuit needs to give the SDR an amount of time greater than the 
Update Interval between powering the 4-20mA circuit and reading the 4-20mA current.   
 
4-20mA Out Source setting determines what value is converted to the 4-20mA output.  The choices include 
stage, stage two, discharge, and volume. 
 
The value of the 4-20mA current output by the SDR will depend on the stage reading and the user set 
variables EGU Hi and EGU Lo.   

• EGU Lo is the stage reading for which 4mA are output 
• EGU Hi is the stage reading for which 20mA are output 

 
E.g. if EGU Lo is 0 feet EGU Hi is 10 feet, a stage reading of 0ft corresponds to 4mA, 5 feet corresponds to 
12mA, and 10 feet to 20mA.  
 
EGU Hi and EGU Lo are expressed in the user chosen units, which can be feet or meters. 
 
When the stage read by the SDR is out of range of EGU Hi and EGU Lo, the following values are output on 
the 4-20mA circuit: 

3.5mA output if stage is less than EGU Lo  
24mA output if stage it is greater than EGU Hi  

 
Using 4-20mA consumes additional power.  The shorter the update interval, the higher the power 
consumption.   
 



When wiring the SDR as a 4-20mA output sensor, please follow this diagram: 
 

‘LOGGER SIDE’ ‘SENSOR SIDE’

DATA LOGGER,
PLC, SDR 

with 4-20ma INPUT
 Option, etc 

O
pt

ic
al

  I
so

la
tio

n

Sensor:

SDR, Shaft 
Encoder, 

Pressure Sensor, 
etc.

4-20ma 
Interface

LOOP POWER
12V to 24V

4-20ma 
Interface

4-20ma INPUT 4-20ma OUTPUT

Sutron SDR
w/4-20 ma OUTPUT OPTION

24 V
Input

4-20ma 
Out

12-24V
Output

Vo

Battery Battery

LOOP POWERED SENSOR INTERFACE TO 
DATA LOGGER CONNECTIONS

NOTE:

1) Applications that are located physically close may share the same battery.

4-20ma 
Input

 
If you are setting up on a test on the bench (without a 4-20mA logger), you will need a power supply, a 
current meter, and an SDR.  Please wire: 

• +12V on the power supply to + of the current meter  
• ground of the current meter to 4-20mA output + (pin 15) on the SDR  
• 4-20mA output – (pin 16) on the SDR to ground on the power supply 

Setup and turn on SDR’s 4-20mA output circuit.  Rotate the SDR shaft.  Note how the current changes with 
the SDR’s stage.  To have the current output match the stage, set EGU Hi to 20 and EGU Lo to 4 and keep 
the stage between 4 and 20. 
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Analog Performance Specifications 

Analog Inputs 
Number Of Inputs: 

• 2 Single Ended   (0 to 5 Volt )  
• 3 Differential ratiometric (common mode 0.05 to 4.5 Volts) 
• 1 4-20mA dedicated input 

Resolution: 
• 24 Bit A/D converter, 0.0015% FS resolution.  

Accuracy: 
• +/- 0.02% FS @ 25C   (5VFS = 100uV) 

Temperature Coefficient: 
• +/- 5 ppm/C typical 
• +/- 10 ppm/C maximum 

Linearity: 
• +/- 0.005% FS 

Reference Output 
• 2.5 Volt, 10 ma max reference output for temperature sensors, bridge references, etc. 

4 to 20 mA Dedicated Input  
• Accuracy 0.02 % FS at room temp 
• Voltage Generation of 18 Volts to source 4-20ma sensor;  50ma capable;  Independently 

switched just for 4-20 ma sensors 
• Reverse protected 

Switched ‘Vbatt’ Output: (Controls Power To Sensors)   
• Output current capability: 200 ma nominal. 
• Short circuit protected. 

4-20mA Output Specifications: 
Accuracy at 25 C +/- 0.2% FS 
Resolution 16 bit over 4 to 20ma range (244nA) 
Drift over Temp +/- 50 ppm/C 
Loop Voltage Range 8 to 36 Volts 
Reading Refresh Rate user settable (Update Interval) 
Quiescent current consumption  
(not counting 4 to 20 ma output) 

575 uA   (typ) 

Operating Temp Range -40C to +60 C 
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Appendix F – Ground Water Monitor device type 

The SDR has the capability of operating as a Ground Water Monitor. The Ground Water Monitor device 
operates very similarly to the standard SDR and shares many of the same features and operative abilities. The 
Ground Water Monitor is different in that it is meant to calculate and log only the water level, therefore it 
has no capabilities to calculate stage or discharge.  The Ground Water Monitor mode is most commonly used 
when monitoring the water levels in wells. 
 

Features 
• Measures water level relative to land surface datum. 
• Allows entry of measurement and reference points. 
• Can measure water level via optical shaft encoder or submersible analog sensor. 
 

Changing the device type 
The device type of the SDR can be set by accessing the “Device type” setting in the “Station Setup” 
submenu on the front panel display of the SDR. When the display reads “Device type” press SET and use the 
arrow keys to choose either “Stage Discharge Rec.” or “Ground Water Monitor”. Press SET again to enable 
the change.  
 
When connected to a PC or PDA, the device type can be changed in SDRComm by selecting “Change 
device type…” in the “Tools” drop down menu.  
 

Changeable Values 
The following is a list of all the values that can be changed by the user: 

• Measurement Interval: 1, 5, 10, 15, 20, 30, 60 minutes  
• Wheel Size: 12 inches, 18 inches, 375 mm circumference 
• Rotation Direction: Clockwise positive, CounterCW Positive 
• Units: Feet, Meters 
• Right Digits: (0..7) 
• Measuring Point: (any distance below or above LSD) 
• Reference Point: (any distance below or above LSD) 
• Battery Type: 12V Gell Cell, 12V Alkaline, Other 
• Password Setup 
• Station Name: xxxxxxxxxx 
• Date/Time: yyyy/mm/dd hh:mm:ss 

 
The overall menu tree for the Ground Water Monitor device type is shown on the following page. 

 
 
 



Errors 
Info 
                        

Logged Water Level 
Right Browses Log
             
Logged Daily Level 
             
Logged Battery 
             
Logged Events 
             

Level xx.xx ft (Water Level) 
       forward in time 
              
Logged value 

 YYYY/MM/DD HH:MM:SS 
             
Distnc xxxxx.xx ft (Distance to Water) YYYY/MM/DD HH:MM:SS 

             
        back in time 

YYYY/MM/DD HH:MM:SS 
             
Battery 13.2V 
             
Logged Data  
Right shows details  
 
 
 
 
 
 
 
 
             
 
 
 
 
 
Station Setup  
Right shows details  
             
Station xxxxx 
YYYY/MM/DD HH:MM:SS 
             

           
Device type 
Ground Water Monitor | Stage Discharge Rec. 
            
Measurement Interval 
1 | 5 | 10 | 15 | 30 | 60 Minutes 
             
Wheel Size 
375mm | 12 inch | 18 inches 
             
Rotation Direction 
CounterCW Positive | Clockwise 
             
Units 
Feet | Meters 
              
Right Digits 
3 
             
Measuring Point  
0.0 Above/Below LSD 
             
Reference Point  
0.0 Above/Below LSD 
             
Battery Type (x.xV) 
12V Gell Cell | 12 V Alkaline | Other 
             
Password Setup 
Info 
             
Station Demo1 
2005/04/01 10:30:57 
             
Default Setup 
             
Software Version 
             
 

Ground Water Monitor mode Menu 

Press SET -- initiate change of 
value 

Changeable values are shown in 
bold on this card 

Press OFF – cancel a change, 
turn display off 

Hold SET – turn on backlight 
Hold  -- increase contrast 
Hold – decrease contrast

Errors: 
Overspeed – shaft rotated too fast 

and encoder may have missed 
some counts. 

Level not set – unit operating without 
initial level setting. 

Battery Voltage low – battery voltage 
less than limit set based on 
battery type. 

Main Menu 
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Setup and Operation 
The Ground Water Monitor device setup and operation is almost identical to that of the standard SDR.  It can 
use either an encoder or a pressure sensor, along with a measuring and reference point set by the user, to 
calculate the water level. When using an encoder, the formula for water level is:  
 

water level = (distance to water) - measuring point (MP) MP “above” Land Surface Datum (LSD) 
water level = (distance to water) + measuring point (MP) MP “below” LSD 
 
When using a pressure sensor the formula is:  
 
water level = offset – depth - measuring point (MP) MP “above” LSD 
water level = offset – depth + measuring point (MP) MP “below” LSD 

 
See the diagram on the below for reference.  
 
*Note that water levels are positive (+) when they are below the LSD and negative (-) when above the LSD. 
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Calibrating the Water Level 
You can calibrate (set) the water level from any of the menus that displays the water level or the distance to 
water.  Simply press the SET key.  The display will change the prompt to set the distance to water.  Use the 
arrow keys to change any of the digits in the display.  When the value is correct, press SET again or press 
CANCEL. 
 
Please note that you are setting the distance to water and not the water level.   
 

Setting the Measuring/Reference point 
The Ground Water Monitor allows for a measuring point (MP) and a reference point (RP) to be specified by 
the user. These values are relative to the LSD (Land Surface Datum) and can be set as “below” or “above” 
the LSD. You can set the measuring and reference point by entering the “Station Setup” submenu on the 
front panel display and pressing the down arrow until the display reads “Measuring Point” or “Reference 
Point”.  Press SET once and use the arrow keys to select if the value will be “Above LSD” or “Below LSD”. 
Press SET a second time and use the arrow keys to change the value.  Pressing SET third time will set the 
value. 
 
 



Appendix G – SDR with GPS 

It is possible to use a GPS to provide the SDR with an accurate, self setting clock.  SDR can be connected to 
a Garmin GPS 16HVS.  SDR needs to be have software version 2.20 or newer to support GPS. 
 

Timekeeping 
When equipped with a GPS, the SDR will keep UTC time.  UTC (Universal Coordinated Time) is an 
internationally accept time standard.  UTC will differ from the local time by a number of hours.  Starting 
with version 3.02, the user can setup the SDR so that it keeps local time by changing the setting Local Time 
Offset.  To get EST, set the local time offset to -5 hours. 
 
If a Sutron Satlink (versions 6.17 and newer) is connected to the SDR via SDI-12 (in addition to the Garmin 
GPS), note that Satlink will set the clock of the SDR once per day.  Please ensure that Satlink’s local time 
offset is equal to the SDR’s local time offset.   
 
An SDR equipped with a GPS will provide a timing accuracy  of ± 1 second. 
 

GPS Installation and Setup 
When first installing the GPS, make sure the GPS is positioned so that it has a clear view of the sky.  Make 
sure to connect the GPS to the SDR via RS232.  Sutron provides a custom RJ45 to RS232 connector for this 
purpose  (the diagram for the connector is on page 75).   
 
After connecting the two devices, go the Station Setup menu on the front panel of the SDR.  Find the entry 
called Garmin GPS and press set to enable the GPS.  Then go back to the top of the menu, and hit the down 
button until the GPS status menu is shown.  If SDR is communicating with the GPS, the menu will say 
GPS initializing.  If the GPS has acquired a time fix, the SDR will show GPS functioning.   
 
Pressing right in the GPS status menu will provide more details. 
If the GPS has locked on satellites and is providing accurate time, the menu will show a message such as  

GPS has valid time 
5 satellites used in time fix 

 
Pressing down from the detailed status menu will show the last GPS time sync.  The time show is the time 
when the GPS last had a time fix.  If it has been more than 12 hours since the last valid time fix, the GPS is 
not working properly and may need to be repositioned (please see page 72). 
 
The next entry in the menu is local time offset.  The user can  setup the SDR so that it keeps local time by 
changing the variable Local Time Offset.  To get EST, set the local time offset to -5 hours. 
 
When installing, it is recommended that the user wait until the GPS has valid time before leaving the station.  
If the GPS does not acquire the time in ten minutes, the GPS should be repositioned so that it has a better 
view of the sky. 
 
Keep in mind that whenever the display is turned on, SDR will power up the GPS.  This helps with GPS 
positioning.  As long as the display is on, the SDR will provide power the GPS, allowing it to track satellites.  
When the display is off, the SDR will power the GPS once an hour for up to 15 minutes. 
 

GPS Positioning 
If the SDR is reporting that the GPS cannot get a time fix, it means that the GPS is unable to get a clear 
view of the sky.  It could also be the case that the GPS is picking up interference.  The best solution is to 
reposition the GPS.  The GPS needs to have a clear view of the sky in order to properly function.   
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Place the GPS antenna in the most open space possible.  Do not place it directly under anything nor directly 
beside something.  Always attempt to achieve a "full sky" view with the antenna. 
 
Place the GPS antenna high up on a pedestal or in a protected location.  Flat surfaces may tend to cover with 
ice and snow more so than elevated locations.  Keep away from areas where birds may nest.   Placement is 
very important and great care should be taken in selecting the location. 
 

GPS Operation 
Once every hour, the SDR will wake up the GPS.  Once the GPS has acquired a time fix (should not take 
more than 40 seconds), the SDR will set its clock and put the GPS in low power mode.  Powering the GPS 
once an hour provides the optimal power consumption. 
 
In addition, whenever the display is turned on, SDR will power up the GPS.  This allows the user to see 
whether the GPS can acquire a time fix and helps in positioning the antenna. 
 

GPS Errors 
If the GPS is either not communicating with the SDR or if the GPS cannot acquire a time fix, the SDR will 
blink the red LED to indicate that there is a problem.  In addition, the SDR will show a message describing 
the problem on the front panel.  Once a day, the SDR will write an event to the log indicating that it has GPS 
problems. 
 
The SDR reporting “No GPS Detected” can indicate that the connector between the GPS and SDR is bad 
(please refer to the section on the connector on page 75) or that the SDR does not have its jumpers set 
properly (please see the section on page 73 about SDR Jumpers) 
 
If the GPS cannot get a time fix, please see the section on GPS Positioning on page 72. 
 
If the SDR reports “GPS Comm Failure”, it means the SDR is detecting data on the RS232 line, but that the 
data is incomprehensible.  It could indicate that the GPS has been improperly configured.  If possible, try 
using a different GPS module. 
 
If a faulty GPS is connect to the SDR, of it the GSP is not connected to the SDR, the SDR will take a full 
minute before deciding it cannot talk to the GPS.  Ensure that the SDR is given enough time to talk to the 
GPS before leaving the station. 
 

SDR Jumpers 
There is a jumper inside the SDR that ensures that the SDR provides 12 Volts on RS232 which the Garmin 
GPS requires in order to function.  If the SDR is reporting “No GPS Detected”, it may be the case that the 
jumper is not properly setup. 
 
Normally, if an SDR is purchased together with a Garmin GPS, Sutron ensures that the jumpers in the SDR 
jumpers are properly setup.  However, if the SDR was purchased at a different time than the GPS, it may be 
the case that the SDR does not have the jumpers setup properly. 
 
There is a way to determine the jumper setup without opening the SDR.  It does require a voltmeter.  Firstly, 
enable the Garmin GPS setting via the front panel.  Then, measure the voltage across pins 5 and 9 of the 
SDR RS232.  Those are the two rightmost pins (closest to right side panel).  One pin is above the other.  If 
the voltage is NOT 12V, GPS will NOT work.  You will then need to open the SDR and set the jumper. 



 
 
To setup the jumper, the SDR case must be opened.  The RIGHT side of the SDR case needs to be opened.  
First remove all eight screws holding the right side of the case.  Then pull hard the right side panel to remove 
it from the case.  There is a gasket that seals the side panel to the case.  This gasket can act like a glue, 
preventing the opening of the side panel.  Make sure to pull hard, or insert a screwdriver between the panel 
and the case to pry the two apart. 
 

 
 
Once the right side panel is removed, the jumper is easily accessible.  Place a connector on jumper J8 so that 
it connects Vbat to the middle pin. 
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In addition to J8, there is another jumper inside the SDR that needs to be properly configured in order for the 
SDR to provide power to the GPS.  However, this jumper is properly setup at the factory and it is unlikely to 
be the cause of the problem.  The jumper in question is J6 (located next to J8).  It should have a connector 
across pins 2 and 3 or have no connector at all. 
 
Please note that the above instructions do not apply to a SDR prototype.  A prototype is labeled as such on 
the side of the SDR Case.  Prototypes (also refereed to as Rev A) use jumper J7: connect pins 5 and 6 
together, and also connect pins 2 and 4 together. 
 

RJ45 to RS232 Connector 
A custom connector is required to get the SDR and the Garmin GPS together.   The connector bridges the 
RJ45 on the Garmin GPS to the RS232 on the SDR.  The table below provides the wiring diagram for the 
connector. 
 
Note: The colors on the Garmin GPS RJ45 do not match the colors of the RJ45 to RS232 converter. 
 
Rj45 pin 
Garmin plug 
color 

RJ45 to Rs232 converter RS232 on SDR Function comments 

1 Red  Blue 9  Power 8 to 40V for 16HVS 
2 Black Orange 5 Ground  
3 Yellow Black 8 CTS Remote 

power on/off 
On if <0.3V, Off if open 
circuit 

4 Blue Red 2 Port 1 Data in NMEA input to GPS 
5 White Green 3 Port 1 Data 

out 
NMEA output from GPS

6 Gray Yellow no connect PPS 1Hz 
7 Green Brown no connect Port 2 Data in RTCM output 
8 Violet White no connect Port 2 Data 

out 
reserved 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Appendix H – Modbus on the SDR 

The SDR can be configured as a Modbus slave device.  In this mode, the unit will respond to properly 
formed Modbus messages in either RTU (default) or ASCII format.  Keep in mind that when Modbus has 
been enabled, the unit will not be capable of connecting to a PC/PDA to download a log or make setup 
changes, but SDRPoll can be used to access log data.   Retrieving log data via SDRPoll  is discussed in 
Appendix 
 
To enable Modbus, goto the Station Setup menu on the front panel of the SDR and press right when the 
Modbus Setup option is shown.  The first option shown is the current status of Modbus, enabled or 
disabled.  Pressing Set will switch between the two options.  If Modbus is disabled and it is turned on, a 
warning message will display showing that GPS and PC communications will cease to work.  Hitting Set 
will enable Modbus. 
 

Modbus Menu Tree 
The following menu tree shows where the Modbus Setup menus are located within the Station Setup menu.   
 

             
Device type 
Stage Discharge Rec. | Ground Water Monitor 
             
Measuring Interval 
1 | 5 | 10 | 15 | 30 | 60 Minutes 
             
Wheel Size 
375mm | 12 inch | 18 inches 
             
Rotation Direction 
CounterCW Positive | Clockwise 
             
Units 
Feet | Meters 
              
Right Digits 
3 
             
Discharge Setup 
             
Modbus Setup  
             
Battery Type (x.xV) 
12V Gell Cell | 12 V Alkaline | Other 
             
Password Setup 
Info 
             
Station xxxxxxxxxx 
YYYY/MM/DD HH:MM:SS 
             
WDID 
             
Enable Garmin GPS 
             

 
 
 
 
 
 
 

           
Modbus Enabled | Disabled 
             
Modbus Device ID 
1 
             
Modbus Baud Rate 
1200 | 2400 | 4800 | 9600 | 19200 | 28800 | 
38400 | 57600 | 115200 
             
Modbus Protocol 
RTU | ASCII 
             
Modbus Parity 
None | Odd | Even 
             
Delay before Tx (ms) 
10 
              
Delay after Tx (ms) 
10 

 
 
 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 Default Setup 
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Modbus Menu Options 
After enabling Modbus, other setup options become available allowing more customization of the unit.  
Initially, each of these settings is defaulted to those expected by the Modbus protocol. 

Modbus Enabled 
 
Default is DISABLED.  Enabling will cause the unit to not communicate properly with any other type of 
device on the DB9 connector for example a PC/PDA or Garmin GPS unit. 
 
Note: If GPS is enabled and Modbus is turned on, the user will be prompted with ‘WARNING! GPS/PC  
comm. Will no longer work!’  Pressing Set will enable Modbus and disable GPS. 

Modbus Device ID 
 
Default is 1.  The device ID is the address that is used by the Modbus master to select which device to 
communicate with.  Each slave on the bus must have a unique device ID ranging from 1 – 247.  Address ‘0’ 
is reserved as the broadcast address. 

Modbus Baud Rate 
 
Default is 19.2 Kbps.  Available communication speeds range from 1200bps – 115 Kbps.   
 
Note: Care must be taken to make sure the selected speed matches that of the master or there will be 
communication problems. 

Modbus Protocol 
 
Default is RTU.  There are two protocols available to the user, RTU and ASCII.   
 
In RTU mode a compatible Modbus master device must generate messages, as strict timing is required for a 
successful communication.  This mode allows for better data throughput than ASCII mode for the same baud 
rate. 
 
In ASCII mode, the user may connect to the device using a serial communication program (ie. Hyperterminal 
or Procomm) set to 7 data bits and 1 stop bit.  Messages can then be sent to the unit by typing the proper 
command.  Each command is prefixed with a ‘:’ and ended with a carriage-return / line-feed (<CR><LF> 
usually just the ‘Enter’ key).  This mode offers much less throughput than RTU since 2 ASCII characters are 
required to describe a single binary byte (e.g., the value 0xB5 would be communicated by sending the ASCII 
characters ‘B’ and ‘5’).  Since a Cyclic Redundancy Check (CRC) is required on each message, the ability to 
send the message via Hyperterminal is almost of no use unless the CRC can be generated by the user.   
 
Note: Care must be taken to make sure the selected protocol matches that of the master or there will be 
communication problems. 

Modbus Parity 
 
Default is Even.  Available choices include Even, Odd and None. 
 
Note: Care must be taken to make sure the selected parity matches that of the master or there will be 
communication problems. 

Modbus Delay before Tx 
 
Default is 10ms.  This identifies the number of milliseconds to wait after asserting CTS before starting data 
transmission.  This is useful if the device is connected to a radio requires keying initialization before data 
transmission.  The possible delay ranges are 10ms – 2000ms. 



Modbus Delay after Tx 
 
Default is 10ms.  This identifies the number of milliseconds to wait after data transmission is complete 
before de-asserting CTS.  This is useful if the device is connected to a radio that requires a hold-off time 
after data transmission has completed.  The possible delay ranges are 10ms – 2000ms. 
   

Modbus Function Codes 
The following table identifies the functions that are supported by the SDR.  Each diagnostic counter is 
cleared when the device is powered up or reset. 
 

Code Hex Subcode Hex 
Read Holding Registers 0x03   
Read Input Register 0x04   
Write Single Register 0x06   
Diagnostic 0x08 Return Query Data 0x00 
Diagnostic 0x08 Clear Counters 0x0A 
Diagnostic 0x08 Return Bus Message Count 0x0B 
Diagnostic 0x08 Return Bus Comm Error 0x0C 
Diagnostic 0x08 Return Bus Exception Count 0x0D 
Diagnostic 0x08 Return Slave Message Count 0x0E 
Diagnostic 0x08 Return Slave Broadcast Count 0x0F 
Diagnostic 0x08 Return Bus Char Overrun Count 0x12 
Write Multiple Registers 0x10   
User Defined Code 0x41 GetLog GL 

 

Identifying Registers 
 
The SDR has two types of data that can be accessed using the Modbus protocol.  These include Holding and 
Input registers. 
 
Holding Registers 
 
Holding registers are reserved for the purpose of setting and getting SDR state data such as the date and time 
and diagnostic counts if the ability to send the above Diagnostic (0x08) command is not available.  The 
following table identifies the holding registers and their locations.  Each of these registers is an unsigned 16-
bit value (if readings registers using an Xpert, set the data type to ushort). 
 

Data Register Valid Data Values 
Hour of current time 1001 0 – 23 

Minute of current time 1002 0 – 59 
Second of current time 1003 0 – 59 

Year of current time 1004 > 2000 
Month of current date 1005 1 – 12 
Day of current month 1006 1 – 31 

Recording status 1007 Always returns 1 
Reset Unit 1008 Write 1 to reset 

Modbus Protocol 1009 0 – RTU 
1 – ASCII 

Force Measurement * 1010 1 – force measurement 
Bus Message Count 1011 Read Only 

Bus Comm Error 1012 Read Only 

 78



 

Bringing the Benefits of Real-Time Data Collection to the World 
Sutron Corporation, 22400 Davis Drive, Sterling, Virginia 20164-4444 

79 

 

Slave Exception Count 1013 Read Only 
Slave Message Count 1014 Read Only 

Broadcast Message Count 1015 Read Only 
Char Overrun Count 1016 Read Only 

 
*Note: When forcing a measurement and an analog sensor is being used to take stage measurements, be 
sure to wait the proper amount of time for a measurement to finish before requesting data.  
 
Input Registers 
 
Input registers return the last measured data from the device including stage, discharge, today and 
yesterday’s volume and battery voltage.  Ideally these values should be requested on a schedule slightly 
lagging the measurement schedule on the SDR.  This will ensure data will follow that found in the SDR log.  
If the last measured data is not acceptable, a live reading can be forced by writing a ‘1’ to the Force 
Measurement (1010) holding register.  Care must be taken to allow enough time to pass for taking a 
measurement before requesting the data, especially if an analog reading is being taken. 
 
Since the SDR works with floating point numbers and Modbus only allows for 16-bit registers, a multiple 
register read can be used to access the entire reading.  The Modbus master device should be configured to 
treat these reads as a single floating point number.  For example, if accessing Last measured Stage via an 
Xpert, read 1 value of type float starting at register 1.  If the quality is also desired, change the number of 
values to 2 and choose ushort for the second reading type.  The complete list of registers and their locations 
are below.  

Data Register 
Last measured Stage (MSW) 1 
Last measured Stage (LSW) 2 

Stage Quality 3 
Last measured Discharge (MSW) 4 
Last measured Discharge (LSW) 5 

Discharge Quality 6 
Volume so far today (MSW) 7 
Volume so far today (LSW) 8 

Volume Quality 9 
Volume yesterday (MSW) 10 
Volume yesterday (LSW) 11 
Battery Voltage (MSW) 12 
Battery Voltage (LSW) 13 

Last measured Stage Two (MSW) 14 
Last measured Stage Two (LSW) 15 

Stage Two Quality 16 
 
In addition to each reading, there may be a quality register that can be read to troubleshoot readings.  Any 
non-zero reading from the quality register means there is something that should be looked into.  The 
following values describe what each quality values means. 
 

Quality Value Description 
1 Overspeed (shaft rotated too fast) 
2 The time has not been set in the unit 
4 The stage has not been set 

8 Not enough readings were available to calculate (usually 
found in volume calculations) 



16 Invalid reading from analog device 
32 Battery voltage was too low to make a reading 

Get Log Command 
The Get Log subcode is used to retrieve log data from the SDR.  The format of the command is as follows: 

GL,logfilename,datetime,recordID,numbytes 
 

• The logfilename can be used to return log entries of specific types.  The available types are data, 
events, and all.   

• The datetime value must be in the following format: MM/DD/YYYY HH:MM:SS. 
• The numbytes value refers to the number of data bytes from the log entry to include in the response, 

not the number of bytes to store in the return packet. Since the master station or transport medium 
may be limited in the number of bytes that can be handled in a single packet, the numbytes value 
should be sized small enough to allow for header and CRC information, as well as translation to 
ASCII if that is the selected protocol (the ASCII protocol uses two bytes to represent every data 
byte).   If numbytes is *, the all log records found will be returned.  Regardless of the requested 
numbytes, only complete log records are returned. 

 
The format of the reply is as follows: 

GLR,status,recordID,numbytes,data[numbytes,data] 
 
The value of status can be any of the following values:  
 

Value Description 
0 Ok. 
1 File not found. 
6 Record not found. 
7 Command format error 

 
The datetime value in the response message is the datetime of the returned  record and, therefore, may be 
different from the datetime in the GetLog command statement.   
 
The data to the end of the file can be read by leaving datetime at the desired starting point and incrementing 
recordID until the status indicates record not found.  The [numbytes,data] represents an additional record of 
data if there is room in the message. 
 
Example: 

command:  GL,data,02/07/2007 15:50:00,80,0 
reply:   GLR,0,0,38,02/07/2007,15:51:00,VBAT,13.16,Volts,G 
  37,10/07/2003,15:51:10,A,10.89,5.2,-25.4 
command:  GL,data,02/07/2007 15:50:00,80,2 
reply:   GLR,0,2,37,02/07/2007,15:54:00,C,10.89,5.2,-25.4,0 

Wrapped for 
illustration 
purposes only. 

 
The GLR response will contain as many log records as can fit into the response.   
 
The numbytes value in the GLR response does not include the comma preceding the data, and refers to the 
number of data bytes from the log that are being returned, not the number of packet bytes used to store the 
response (which would be twice the data bytes when ASCII protocol is selected).  
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Appendix I – Dual Sensor 

Advanced Menus 
SDR software version 3.00 features dual sensor (see below) and SDI-12 master (see below) options.  If your 
SDR comes without an analog option, you will not be able to take advantage of the new features until 
advanced menus are enabled.  To enable, use the front panel and navigate to Station Setup -> Other Setup -
> Advanced Menus.  If your SDR is equipped with the analog option, the automatic menus are always 
enabled. 
 
Advanced menus affect measurements.  If you are using only one sensor, advanced menus are not 
appropriate.  If, however, you want to setup a dual sensor station, advanced menus are a must.  Below are 
listings of relevant portions of basic and advanced menus. 
 
Basic menus (ideal for a shaft encoder measurement) 
Station Setup 
 Wheel Size 

Direction 
Measurement Interval 
Units 
Right Digits 
Averaging Time 

 
Advanced menus (required for dual sensors) 
Station Setup 

Measurement Setup 
Stage Sensor 

Sensor Type 
Wheel Size   (shaft encoder only) 
Direction    (shaft encoder only) 
Analog Warmup   (analog only) 
Slope           (analog only) 
Offset          (analog only) 
SDI-12 Address  (SDI-12 only) 
SDI-12 Command     (SDI-12 only) 
SDI-12 Parameter (SDI-12 only) 
Averaging Time 
Test Sensor         (analog and SDI-12) 

Second Sensor 
Sensor Type 
Wheel Size   (shaft encoder only) 
Direction    (shaft encoder only) 
Analog Warmup  (analog only) 
Slope           (analog only) 
Offset          (analog only) 
SDI-12 Address  (SDI-12 only) 
SDI-12 Command     (SDI-12 only) 
SDI-12 Parameter  (SDI-12 only) 
Averaging Time 
Test Sensor         (analog and SDI-12) 

Measurement Interval 
Units 
Right Digits 
Send SDI-12 Command (SDI-12 only) 



 

Dual Sensor 
With SDR software version 3.00, a second water level sensor has been added.  The second sensor is disabled 
by default and must be enabled through Setup->Measurement Setup->Secondary sensor setup.   
 
If your SDR comes without an analog option, you will not be able to take advantage of the second sensor 
until advanced menus are enabled.  To enable, use the front panel and navigate to Station Setup -> Other 
Setup -> Advanced Menus 
 
The secondary sensor can be setup to be of any type, including shaft encoder, SDI-12, or analog (if the 
analog option board is installed), just like the primary sensor.   
 
Once enabled, the secondary sensor will be measured and logged at the same time as the primary sensor.  If 
enabled, the secondary sensor will show on the front panel immediately under the primary sensor.  For the 
SDR, the secondary sensor is labeled Stage Two.   For the DitchMaster, the sensor is labeled Canal Level. 
 
If the secondary sensor is enabled, a the dual sensor discharge equation becomes available.   The dual sensor 
equation is the only discharge type that takes both sensor into account.  For the dual sensor discharge setup, 
the primary sensor is considered the downstream sensor, and the secondary sensor the upstream sensor. 
 
Readings made by the secondary sensor are accessible just like the readings made by the primary sensor: via 
front panel, RS-232, Modbus, and SDI-12. 
 
Both sensors share these settings: 

Measurement Interval 
Right Digits  
Units 

 

Dual Sensor Discharge Equation 
If the secondary sensor is enabled, a new type of discharge equation becomes available.  Please see section 
Appendix I – Dual Sensor on using dual sensors.   The dual sensor discharge equation uses two sensors to 
compute the discharge.  Stage one is the downstream sensor.  Stage two is the upstream sensor.  Water flows 
by the upstream sensor before it flows by the downstream sensor. 
 
Dual sensor (submerged orifice equation) : 

Q = Cd* A √(Hu-Hd)G 
Q is the computed discharge. 
Cd is the discharge coefficient which can be changed by the user in discharge setup.  0.6 is a 

generic value for a slide gate. 
Hd is the downstream water level (Stage) 
Hu is the upstream water level (Stage Two) 
G is 32.175 ft/sec/sec (constant and not changeable) 
A is the gate area opening that is setup by the user.  

 

SDI-12 Logger 
 
SDI-12 is a standardized three wire digital interface.  Many manufacturers provide SDI-12 sensors that 
measure different environmental effects.  SDI-12 sensors provide digital data which improves their reliability 
and accuracy in terms of logger sensor communications.   
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SDR software version 3.00 allows the SDR to act as an SDI-12 logger.  SDR can be setup to collect data 
from an SDI-12 compliant sensor.  By selecting SDI-12 as the sensor type, the SDR will collect data on the 
SDI-12 bus. 
 
SDR does not provide power on the SDI-12 + connector.  The sensor will have to be powered from a 
different source.  You may use the same power source for both the SDR and the sensor. 
 
If SDR is setup to collect data from an SDI-12 sensor, SDR ceases to be an SDI-12 sensor.  This means that 
data cannot be collected from the SDR via the SDI-12 bus.  The SDR cannot function as both an SDI-12 
sensor and a SDI-12 logger.  It can do one or the other but not both. 
 
It is possible to hook up two SDR units using the SDI-12 bus.  One SDR would become the logger and 
collect data form the other SDR.  One SDR would collect data not only from its shaft encoder, but also from 
the other SDR.  This setup may be useful if only one modem is available at the site.  It may also be useful 
when computing discharge from an upstream and downstream sensor. 

SDI-12 Logger Setup Guide 
Before you can use the SDI-12 logger features, advanced menus need to be enabled if your SDR does not 
have the analog option.  To enable, use the front panel and navigate to Station Setup -> Other Setup -> 
Advanced Menus.    
 
One (or even both) of the SDR’s dual sensors need to be setup for SDI-12.  This guide will provide an 
example of how to setup the secondary sensor as SDI-12.  Use the Station Setup -> Measurement Setup -> 
Second Sensor menus.  First turn on the secondary sensor, then set the secondary sensor type as SDI-12.   
 
Once the secondary sensor is enabled and setup as SDI-12, the setup is complete for most situations.    Even 
thought there are three more settings that control SDI-12 behavior, the default setup is likely sufficient.  Use 
the Station Setup -> Measurement Setup -> Second Sensor -> Sensor test menu to see if you get valid results 
from the SDI-12 sensor.  If not, proceed with the rest of the setup. 
 
There are the SDI-12 settings and their default values: 



 
Setting Default 
SDI-12 Address  0 
SDI-12 Command M! 
SDI-12 Parameter 1 

 
 
Setting the SDI-12 address of the sensor is a two step process.  The sensor has an address and the SDR has 
the address it will get the data from.  Both the SDR and the SDI-12 sensor can change the address.  You need 
to setup both the addresses match. 
  
It is easy to change the address the SDR will get the data from.  Simply change the SDR setup field Station 
Setup -> Measurement Setup -> Second Sensor -> SDI-12 Address.  
 
Most sensors default to address 0.  To see what address the sensor is at, issue the ?I! command.  To change 
the address of the sensor, you may use the Diagnostics -> Send SDI-12 Command menu.  To change the 
sensor from address 0 to address 1, send the 0A1! command.   
 
To get data from the sensor, the SDR needs to send a command to it.  That command is  usually M!.  Please 
refer to the sensor’s guide to find out what command should be issued.  Use the menu Station Setup -> 
Measurement Setup -> Second Sensor -> SDI-12 Command  to change what command the SDR issues to the 
sensor.  
 
Some sensors will respond with multiple data values.  The SDI-12 Param designates which of these data 
values the user is interested in.  The default value of 1 means use the first value reported.  Please refer to the 
sensor’s documentation to find out which parameter is appropriate.  
 
Once the SDI-12 setup is complete, use the Station Setup -> Measurement Setup -> Second Sensor -> 
Sensor test menu to see if you get valid results from the SDI-12 sensor.  If not, check the cabling and the 
SDI-12 setup.  Additionally, the SDR provides a means of directly issuing SDI-12 commands.  That menu is 
Diagnostics -> Send SDI-12 Command.  To see if a sensor is responding, issue the ?I! command.  If no 
response is received, the sensor or the wiring is faulty.  Remember that the SDR does not provide power 
on the SDI-12 + connector.  Use BAT+ instead. 

Averaging 
With SDR software version 3.00, an averaging option has been added.  Under each sensor’s setup, there is an 
averaging time, expressed in seconds.  If that time is zero (which is the default), no averaging is done.  If it is 
not zero, the SDR will collect data for however long the averaging time is setup for. 
 
Averaging can be found under Station Setup ->Averaging if advanced menus are not enabled.  If they are, 
there is going be an independent averaging setting for each sensor.  The stage sensor’s averaging can be 
found in Station Setup -> Measurement Setup -> Stage Sensor ->Averaging. 
 
SDR does simple averaging, meaning that it will collect data the user specified amount of time.  Once the 
time is up, it will sum up all the samples and divide the sum by the number of samples collected. 
 
Please note that the SDR’s Stage reading on the front panel will only update as fast as the averaging 
interval.  That means that if the averaging time is set to 10 minutes, the display will update only once every 
10 minutes!   
 
If setup for shaft encoder or analog, the SDR will collect approximately two samples per second.  SDI-12 
sampling speed will depend on the SDI-12 sensor, and will be done as fast as the data becomes available. 
 
For example, with a shaft encoder, if averaging is set to 5 seconds, the SDR will collect 10 samples from the 
encoder, sum them up, and divide the resultant sum by 10.  The final result is the stage.   
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Make sure the averaging time is less than the measurement interval.  If the averaging time is close to the 
measurement interval, the SDR may miss measurements!  This means that if the Measurement Interval is set 
to 1 minute, make sure the averaging interval is significantly less than 60 seconds.  
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